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Important and general information

1 Important and general information

1.1 Important information

Please follow these instructions before and during the use and application on any IPETRONIK
product!

1.1.1 Safety and Warning instructions
Please follow the instructions and information as contained in the user manual!

1. The user can influence an electronic system by applying the IPETRONIK product. This might
cause risk of personal injury or property damages.

2. The use and application of the IPETRONIK product is permitted only to qualified professional
staff, as well as, only in appropriate manner and in the designated use.

3. Before using an IPETRONIK measurement system in the vehicle it has to be verified that no
function of the vehicle, which is relevant for secure operation, might be influenced:
- by the installation of the IPETRONIK measurement system in the vehicle,
- by an potential malfunction of the IPETRONIK system during the test drive.

In order to avoid possible danger or personal injury and property damages, appropriate actions are
to be taken; such actions have to bring the entire system into a secured condition (e.g. by using a
system for emergency stop, an emergency operation, monitoring of critical values).

Please check the following points to avoid errors:

- Adaption of sensors to components of the electrical system / electronics, brake system, engine
and transmission control, chassis, body.

- Tap of one or several bus systems (CAN, LIN, ETHERNET) including the required electrical
connection(s) for data acquisition.

- Communication with the vehicle’s control units (ECUSs), especially with such of the brake system
and/or of the engine and transmission control (power train control system).

- Installation of components for remote data transmission (mobiles, GSM/GPRS modems, WiFi
and Bluetooth components).

4. Before directly or indirectly using the data acquired by an IPETRONIK measurement system to
calibrate control units, please review the data regarding to plausibility.

5. With regard to the application of IPETRONIK products in vehicles during use on public roads the
manufacturer and/or registered user of the vehicle has to ensure that all changes/modifications
have no influence concerning the license of the vehicle or its license of operation.

6. User does agree to the instructions and regulations as mentioned above. In case the user does
not agree with the instructions and regulations as mentioned above, he has to notify this expressly
and immediately in writing to IPETRONIK before confirming the sales contract.

1.1.2 Liability, Warranty, Copyright, License agreement
Limitation of liability

Any liability of IPETRONIK, its representatives, agents and the like, especially with regard to personal injury
or damage to property of any kind, shall be excluded (within the legally admissible framework), as far as, the
instructions and warnings, as mentioned below, have not been followed.

Warranty
Products, accessories and services have a 24 months warranty.

All product data, specifications, drawings, etc., correspond to the current condition of the indicated creation
date. For the purpose of optimizing technical processes and production, some details of our modules and
accessory components may be modified at any time without prior notification.

Although the present document has been prepared with the utmost attention to detail, it may not be exempt
of misprints, typing or transcription errors. These errors are not covered by any warranty.
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Important and general information

Copyright and Duplication

All rights reserved to IPETRONIK GmbH & Co. KG, in particular those of property, copyright and trademarks.
The rights related to any third party trademarks mentioned in the present document remain unaffected.

This document may not be duplicated, partially or entirely without the prior approval from IPETRONIK GmbH
& Co. KG. All graphics and explanations are copyright protected. Any use beyond the scope of the document
is prohibited.

Software license agreement

This software is property of IPETRONIK GmbH & Co. KG, and is protected by copyright laws. Its total or
partial reproduction is strictly forbidden.

A valid software license is required to use the software.

IMPORTANT - READ CAREFULLY! THIS IS A LEGAL AGREEMENT BETWEEN YOU, LICENSEE, AND
IPETRONIK GMBH & CO. KG/IPETRONIK INC. ("IPETRONIK"). BY CHECKING “| ACCEPT ALL OF THE
TERMS CONTAINED IN THE ABOVE AGREEMENT” DURING INSTALLATION, COPYING OR USING
THIS PRODUCT IN ANY WAY YOU ACKNOWLEDGE THAT YOU HAVE READ THIS LICENSE AND THAT
YOU UNDERSTAND AND EXPRESSLY AGREE TO BE BOUND BY THE TERMS AND CONDITIONS SET
FORTH BELOW.

1. Definitions

a. SOFTWARE is defined as computer program in object code or machine-readable format,
together with any and all modifications, enhancements, updates, and improvements provided
by IPETRONIK as well as any subsequent versions, corrections, bug fixes, enhancements,
updates or other modifications, regardless of the source. The term “Licensed Software” shall
not include the source code version of the Licensed Software.

b. EQUIPMENT is defined as automotive measuring equipment produced by IPETRONIK as well
as other parties.

c. LICENSEE is defined as the recipient of this SOFTWARE and any of its employees, agents or
representatives.

d. MODIFY or MODIFICATION is defined as change to the SOFTWARE by LICENSEE in order
to customize the SOFTWARE for use solely by LICENSEE.

2. License Terms

a. Aslong as LICENSEE complies with all terms in this Software License Agreement
IPETRONIK grants LICENSEE a non-exclusive, non-transferable license to load and use the
SOFTWARE upon the terms and conditions set forth below.

b. LICENSEE has the right to load the SOFTWARE for use on any internal computer or piece of
EQUIPMENT, as long as it is only on one computer or piece of EQUIPMENT at any given
time.

c. LICENSEE will notify all of its employees, agents or representatives permitted access to the
SOFTWARE of the duties and obligations under this Software License Agreement.

d. LICENSEE has the right to MODIFY the SOFTWARE for use on any internal computer or of
EQUIPMENT, as long as it is only on one computer or piece of EQUIPMENT at any given
time.

e. Any MODIFICATION(S) to the SOFTWARE are subject to the terms and conditions of this
Agreement.

f.  LICENSEE may not:

i. Loan, rent, lease, give, sublicense, distribute, transmit or otherwise transfer the
SOFTWARE, or otherwise exercise any of IPETRONIK's legal rights in and to the
SOFTWARE, or any derivative works of the SOFTWARE, in whole or in part, except with
the prior written agreement of IPETRONIK.

i. Copy, translate, reverse engineer, decompile, disassemble the SOFTWARE, in whole or
in part.

iii. Except as provided is Section 2(d), create derivative works based on the SOFTWARE, in
whole or in part.
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iv. Remove, modify or cause not to be displayed any copyright or trademark notices, license
agreements, or startup messages contained in the programs or documentation.

v. Transmit or otherwise export outside of the Unites States any of the SOFTWARE or
technology in violation of United States or other applicable laws or regulations.

3. Ownership of Intellectual Property

LICENSEE agrees and acknowledges that the SOFTWARE is being provided to it only for use in
EQUIPMENT in the ordinary course of business and that LICENSEE agrees and acknowledges
that IPETRONIK is the owner of all title and proprietary rights in the SOFTWARE, including, without
limitation, any and all patents, copyrights, trademarks or any other intellectual property rights
associated with it under the laws of the United States or any jurisdiction throughout the world. No
right, title or interest in the SOFTWARE or any IPETRONIK patent, copyright, trademark, or any
other intellectual property right is transferred to LICENSEE or any other party through this Software
License Agreement.

4. Disclaimer of Warranties; Liability Limitations

a.

THE SOFTWARE IS PROVIDED TO YOU "AS IS". THERE ARE NO WARRANTIES OF ANY
KIND, WHETHER EXPRESS OR IMPLIED, INCLUDING BUT NOT LIMITED TO THE
WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE AND
COMPATIBILITY, AND TITLE.

LICENSEE ASSUMES ALL RISK AS TO THE SELECTION, USE, PERFORMANCE AND
QUALITY OF THE SOFTWARE. IN NO EVENT WILL IPETRONIK OR ANY OTHER PARTY
WHO HAS BEEN INVOLVED IN THE CREATION, PRODUCTION OR DELIVERY OF THE
SOFTWARE BE LIABLE FOR SPECIAL, DIRECT, INDIRECT, INCIDENTAL OR
CONSEQUENTIAL DAMAGES, INCLUDING LOSS OF PROFITS OR INABILITY TO USE
THE LICENSED MATERIAL. IN NO EVENT SHALL IPETRONIK'S LIABILITY FOR ANY
DAMAGES OR LOSS TO LICENSEE OR TO ANY THIRD PARTY EXCEED ANY LICENSE
FEE ACTUALLY PAID BY THE LICENSEE TO IPETRONIK FOR THE SOFTWARE.

Since some states or jurisdictions do not permit the exclusion of implied warranties or
limitation of liability for consequential damages, in such states or jurisdictions, the liability is
limited to the fullest extent permitted by law.

5. Intellectual Property Infringement Indemnification

a.

IPETRONIK shall defend, indemnify, and hold LICENSEE harmless from and against any

claims and fees (including attorneys’ fees), damage awards arising in connection with a claim

that the licensed SOFTWARE or documentation, when properly used, infringes upon any

presently existing, valid and enforceable United States patent, trademark, or other intellectual

property right, provided that:

i.  such claim of infringement is not based on any Modification or action taken or suffered by
LICENSEE other than the use of the licensed SOFTWARE and documentation in
accordance with the terms and conditions of this agreement;

ii. such claim of infringement is not based on any action by LICENSEE in modifying the
SOFTWARE pursuant to the terms of Section 2(d).

iii. LICENSEE promptly notifies IPETRONIK of such claim in writing at
support@ipetronik.com, and gives IPETRONIK exclusive control over the defense and
settlement of such claim;

iv. LICENSEE provides such cooperation and assistance, at IPETRONIK'S expense, as
IPETRONIK may reasonably request to settle or oppose any such claim; and

v. such claim of infringement is based only on the licensed SOFTWARE and documentation
as provided to LICENSEE.

In the event of any infringement claim for which IPETRONIK is liable pursuant to section 5 (a),

IPETRONIK may, at its sole option and expense:

i.  procure for LICENSEE the right to continue using the licensed SOFTWARE or
documentation;

i. modify or amend the licensed SOFTWARE or documentation so that it becomes non-
infringing;

iii. replace the licensed SOFTWARE or documentation with a non-infringing substitute; or
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iv. recover the infringing licensed software and documentation from LICENSEE and repay to
LICENSEE all license fees paid to IPETRONIK in connection therewith, less a reasonable
amount based on LICENSEE's use prior to such recovery and refund.

This Article 5 sets forth IPETRONIK'’s sole obligations and liability for intellectual property
infringement. These indemnity provisions only apply to the SOFTWARE as originally licensed
to LICENSEE and do not cover any MODIFICATIONS made by LICENSEE or any other third

party.

6. Limitation of Liability

a.

EXCEPT WITH RESPECT TO ITS INTELLECTUAL PROPERTY INDEMNIFICATION
OBLIGATIONS, AS SET FORTH IN ARTICLE 5, IN NO EVENT SHALL IPETRONIK BE
LIABLE FOR SPECIAL, INDIRECT OR CONSEQUENTIAL DAMAGES (INCLUDING,
WITHOUT LIMITATION, LOST PROFITS, LOST DATA, OR LOST SAVINGS), EVEN IF
IPETRONIK WAS ADVISED OF THE POSSIBILITY OF SUCH DAMAGES. FURTHERMORE,
IPETRONIK’S LIABILITY (WHETHER IN CONTRACT, TORT, OR OTHERWISE) ARISING
OUT OF, OR CONNECTED WITH, THIS AGREEMENT OR THE LICENSED SOFTWARE OR
DOCUMENTATION SHALL IN NO CASE EXCEED THE PAYMENTS RECEIVED BY
IPETRONIK FROM LICENSEE FOR THE LICENSED SOFTWARE AND DOCUMENTATION.

EXCEPT IN CONNECTION WITH ITS OBLIGATIONS UNDER ARTICLE 5:

i. INNO EVENT SHALL LICENSEE BE LIABLE FOR SPECIAL, INDIRECT OR
CONSEQUENTIAL DAMAGES (INCLUDING, WITHOUT LIMITATION, LOST PROFITS,
LOST DATA, OR LOST SAVINGS), EVEN IF LICENSEE WAS ADVISED OF THE
POSSIBILITY OF SUCH DAMAGES; AND

i. LICENSEE'S LIABILITY (WHETHER IN CONTRACT, TORT, OR OTHERWISE)
ARISING OUT OF, OR CONNECTED WITH, THIS AGREEMENT OR THE LICENSED
SOFTWARE OR DOCUMENTATION SHALL IN NO CASE EXCEED THE PAYMENTS
OWED TO LICENSOR FOR THE LICENSED SOFTWARE AND DOCUMENTATION.

7. Indemnification Obligations of LICENSEE

a.

LICENSEE shall defend, indemnify, and hold IPETRONIK harmless from any claims, losses,
expenses, fees (including attorneys’ fees), costs or damages arising in connection with a
MODIFICATION or LICENSEE’S unauthorized use of the Licensed Software or
Documentation.

8. Merger Clause

a.

LICENSEE agrees that this Software License Agreement is the complete and exclusive
agreement between LICENSEE and IPETRONIK governing the SOFTWARE. This Software
License Agreement supersedes and merges all prior agreements with IPETRONIK concerning
the SOFTWARE and can only be modified by a subsequent written agreement signed by
IPETRONIK. To the extent that there is any conflict between this Software License Agreement
and any IPETRONIK purchase order or other written agreement for the purchase of
IPETRONIK parts or products, the terms of the purchase order or written agreement control.

9. General

a.

If any provision or portion of a provision of this Software License Agreement is determined to
be invalid or unenforceable, it shall be deemed omitted and the remaining provisions of this
Software License Agreement shall remain in full force and effect to the fullest extent permitted
by law.

LICENSEE may not assign or transfer all or part of this Software License Agreement to any
third party without the express written approval of IPETRONIK.

This Software License Agreement will be governed by the laws of the State of Michigan
without regard to its conflict of laws provisions.

All disputes arising out of, or in connection with, the present contract shall be finally settled
under the Rules of Arbitration of the International Chamber of Commerce by one or more
arbitrators appointed in accordance with the said Rules.
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Important and general information

1.2 General information

1.2.1 About this manual

The manual describes the structure of the IPEmeasue data logger devices M-LOG, S-LOG, FLEETIog, and
IPElog, as well as, peripheral devices and accessories components.

1.2.2 Version

This manual has the version number 03.51.01, released August 2013 © All rights reserved !

IPEmotion Plugin IPETRONIK-LOG

Contents described in this document relates to the current release version 03.51.01.

To run this Plugln an IPEmotion release = V02.00 has to be installed on your computer.

IPEmotion

Contents described in this document relates to the release versions 01.09. to 3.03

1.2.3 Legend of used icons

Tip This icon indicates a useful tip that facilitates the application of the software.

Information  This icon indicates additional information for a better understanding.

Attention! This icon indicates important information to avoid potential error messages.
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Important and general information

1.2.4 New features, Changes

Please also refer to the latest release notes at:
c:\Program Files (x86)\IPETRONIK\IPEmotion Plugin IPETRONIK LOG V03.5x.xx\Help\

Plugin IPETRONIK-LOG V03.51
No. Feature
1 PIN assignment

Traffic storage groups

3 Extension for IPElog
(requires PIC = V01.01.07,
FPGA = V01.02.08

4 CCP

5 Upload and download

6 Event controlled measurement
7 Masks

8 File name length

9 Stop date, Stop time

10 PreTriggerTime, PostTriggerTime

Plugin IPETRONIK-LOG V03.50

No. Feature
1 Notes
Version reference
SC1200
IPElog
2 Status signal "FIFO overrun”
3 Debounce time of the remote
signal
4 Extensions TESTdriveCmd.xml
5 Differnt init modes for module
initialization
6 Status e-mail with snap shot report
7 Limit display with M-VIEWvga
8 V-TABs enable clear text display

Logger_Manual_V03.51

Release July 2013

Description

FLEETIog and IPElog added

Traffic measurement now support different storage groups

NoMessageLost function (NML)

WakeOnCAN can be activated for each channel

up to 6 ID triggers

Logger restart using WakeOnCAN or remote signal

CAN-ID trigger now StartNotStopTrigger (instead StartOnly)
PIC update per job executable

Status indication of the flap for the storage medium with
M-VIEWfleet

Command CCP_DISCONNECT implemented
Supported with different transfer media (Modem, WiFi)

CAN data acquisition based on traffic measurement but
handled as signal measurement (DAT format)

for CAN identifiers are supported now

Up to 260 characters are allowed for file names of the external
library and configuration files.

Stored as project property with the traffic file

Supported as project property

Release October 2012

Description

Logger Plugin = 3.5x requires IPEmotion = 2.xx
M-LOG with SC1200 is no longer supported
Requires TESTdrive / Plugin IPETRONIK-LOG = 3.5x

Indicates the data processing status.
Output 0 = OK, Ouput 1 = processor overloaded

Configurable delay time within a range of 0 ... 5 seconds. The
signal status ist valid if the remote signal lasts for this time
without interruption.

New jobs "OnOK" and "OnError" used for audible alarm of the
job "OnConnect"

Connected IPETRONIK modules will be initialized on
command: Never, Once-only, Always.

Each time the trigger condition is fulfilled, the current signal
values (configured in the mail group) will be sent per mail.

Indication of limit violation has been revised.

Individual text can be assigned to different signal values (or
ranges) which is respectively displayed (instead of digits).
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Important and general information

1.2.5 Support
Headquarter:

IPETRONIK GmbH & Co. KG
Im Rollfeld 28

76532 Baden-Baden, Germany

Phone +49 7221 9922 0
Fax +49 7221 9922 100

info@ipetronik.com
www.ipetronik.com

Limited commercial partnership with its head office in Baden-Baden, registry court HRA No. 201313

IPETRONIK Verwaltungs-GmbH Baden-Baden is an individually liable society, registry court Mannheim HRB
No. 202089

CEOs: Erich Rudolf, Andreas Wocke

Technical support and product information

www.ipetronik.com e-mail: support@ipetronik.com

1.2.6 Related documentation

IPEmotion

The documentation IPEmotion.pdf provides you with a description and useful information related to
IPEmotion. This documentation is stored in the following standard language dependent directory:
C:\Programs\IPETRONIK\IPEmotion Vxx.xx.xx\Help

1.2.7 Documentation feedback

At IPETRONIK, the technical publications team strives to produce documentations of the highest quality and
values your feedback as a reader and user. If you have any comments or suggestions regarding our product
manuals, contact us under support@ipetronik.com .

When commenting on our products, please include the following information:
Version number
Name of the guide
Page number or section title

Brief description of the content (e.g. inaccurate instructions, grammatical errors, or information that
require clarification)

Any suggestions for a general documentation improvement
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System basics

2 System basics

2.1 Datalogger applications (extract)
2.1.1 Configuration, Online measurement using Ethernet

2.1.2 Fleet datalogger
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System basics

2.2 Connecting devices via CAN bus
2.2.1 Basics of CAN bus
CAN-Standard

The communication of the IPETRONIK SIM and M devices takes place by using the CAN bus according to
the CAN 2.0 A (11 Bit Identifier) and CAN 2.0 B (29 Bit Identifier) specification. Each software application,
which is able to detect CAN data via a suitable interface, can detect the device data and process. Examples:
CANalyzer, INCA, DIAdem, LabVIEW. The device configuration takes place by using the CAN bus and the

IPETRONIK configuration software.
Structure of a CAN message
Remoteframe CAN 2.0A (11 Bit Identifier)

recessive

Identifier RTR IDE r0 DLC

Data
11 Bits 1Bit 1Bit1Bit 4Bit 0..8 *8 Bit

Start
1 Bit

CRC
15 Bit

Remoteframe CAN 2.0B (29 Bit Identifier)

ACK
2 Bit

EOF + IFS
10 Bit

User data within the CAN
message.

Maximum 8 values in the byte
format or 4 values (4 channels)
in the Word format can be
transferred depending on the
CAN message.

ecessive

RTR 1 ro DLC
1Bits1 Bit1 Bit 4 Bit

Identifier
18 Bits

Start
1Bit

Identifier SRR IDE
11 Bits 1Bit 1Bit

CAN 2.0A (11 Bit Identifier)

Data
0..8 *8 Bit

CRC
15 Bit

ACK
2 Bit

EOF + IFS
10 Bit

CAN 2.0A (11 Bit Identifier)

Description
Start of Frame

Identifier

Identifier Extension (1)
Identifier (extended)

Remote Transmission Request

Number of following data bytes
Data bytes

Error Identification Code
Acknowledge

End of Frame

Sum

Bits Description Bits
1 SOF Start of Frame 1 SOF
11 ID Identifier 11 ID
1 SRR
1 IDE Identifier Extension (0) 1 IDE
18 ID
1 RTR Remote Transmission Request 1 RTR
1 rl
1 r0 1 r0
4 DLC Number of following data bytes 4 DLC
64 Data Data bytes — 64 Data
15 | CRC  Error Identification Code 15 CRC
2 ACK Acknowledge 2 ACK
10 EOF End of Frame 10 EOFS
110 Sum 130
A 4
Word Byte Bit (Message layout in the displaying format , Intel Standard*)
0 0 7 6 5 4 3
1 15 14 13 12 11
1 2 23 22 21 20 19
3 31 30 29 28 27
2 4 39 38 37 36 35
5 47 46 45 44 43
3 6 55 54 53 52 51
7 63 62 61 60 59

Logger_Manual_V03.51
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2 1 0
10 9 8
18 17 16
26 25 24
34 33 32
42 41 40
50 49 48
58 57 56
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System basics

Access to the CAN bus, Transferring properties

The CAN bus allows a safe and effective data transfer of the connected devices (non-destructive bitwise
arbitration = resource distribution to different devices). The CAN bus is therefore used as a standard
communication medium in the automotive area and the industrial automation.

The most important characteristic CAN bus properties are:
» Every bus participant (node) can send, as well as, receive.

» First of all, the node, which wants to send, needs the authorization. All participants become
automatically a recipient (There is no abortion of the data sending process > non-destructive
collision).

» No stations are addressed but messages.
» Every message is characterized by its name (Identifier).
» The less the identifier, the higher the message priority.

» A message can transport up to 8 * 8 Bit = 64 Bit (8 Byte) user data, whereas each message
requires 110 Bit or 130 Bit (Extended ID).

» Depending on the hardware and the bus line length, up to 1 MBit/ s can be transferred.
The following important conclusions result from the properties above:

» The less the bus load, the less the probability of a “Bus access conflict” (you can call this a real- time
capable area).

» A high bus load forces stations to loose messages with a high identifier or to send them more
slowly. Messages with a high identifier can “get lost”.

» Not sent messages are only registered by the “Recipient node” because data are missing. If no
timeout has been defined, the last valid value is generally sent, i.e. a mistakenly constant value.

Transfer rate, Bus line length

The CAN bus supports a max. transfer rate of 1 MBit/s according to Norm 1SO 11898-2.
This value is limited in practice by the following points:

» the bus line length

» the branch line length to the CAN stations

» the bus lines quality and the plug contacts

» the bus line design (twisted, single or two-wire bus)
» bus connection structure and

» type and strength of external perturbations

Example
Data rate on the bus 1 MBit/s = 1 us/Bit
Data length of a CAN message 130 Bits gesamt
User data in a message 64 Bit = 4 values with 16 Bit resolution each
Time for a CAN message 130 Bit x 1 ps/Bit = 130 pus/message
i.e. 4 values require 130 pus
Calculating the total sampling rate 130 ps match 7.69 kHz
Converted to one channel 4 x 7.69 kHz = 30.76 kHz
Theoretical transfer rate 30 channels with 1 kHz = 30 kHz
Practical experiences 26 channels with1l kHz = 26 kHz
The value is lower at guaranteed synchronity.

If CAN messages are not completely used (e.g. only three 16 bit values instead of four per message), less
data can be transferred although the sum sampling rate has not yet reached the maximum. This also applies
if different sampling rates are defined in one system, because the data division to the CAN messages is not
time-optimized (minimum time required).
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System basics

2.3 Ampacity and voltage drop

Besides the fact that the max. bus line length is defined by the desired data transfer rate, the ampacity and
the voltage drop in the system have primarily to be checked. This is especially important for systems with a
high number of devices and/or long connections lines of the devices (e.g. distributed systems with
connection lines of 3 m (9.84 ft) and more between the device groups). Additional actions should be taken
accordingly to the situation.

2.3.1 Ampacity

The maximum current via the M-CAN system cables (e.g. 620-560.xxx) is 4 A (heat generation by transition
resistances of the plug contacts).

The system capacity and therefore the power consumption can approximately be calculated by using the
number of devices (including the sensor supply). A direct power acquisition in the real system provides exact
values.

We recommend one or several of the following actions if the limit value is exceeded:

» Increasing the supply voltage of the devices (e.g. 24 V DC power supply or 42 V DC
instead of 12 V)

» Centered voltage supply via T connection or as close as possible to the devices with high
power requirements (rather than at the beginning or end of the system chain)

» Additional system supply via a T connection at a suitable position

2.3.2 Voltage drop

Even if the limit value for the ampacity is not reached, long lines in an extensive system can cause
perturbations in the acquisition process. This mainly applies to devices at the end of the system chain,
because the voltage of the last devices does not exceed the input threshold of 9 V (due to a high voltage
drop in the system).

We recommend one or several of the actions mentioned above.

The voltage drop can be calculated by using the following formula:

U=Rx
R = 2 X Rcable jaim) X Lengthcapie [m]

| = Ppevices [W] ! Upevices V]

For estimating the voltage drop, a resistance of

> 50 mQ/m for the M-CAN cables and
> 35 mQ/m for the SIM-CAN cables

can be used including the transition resistances of the plug contacts. Systems, which are in the limit range of
the voltage drop, should be controlled in individual cases. To do so, our support will be pleased to assist you.

As the power consumption of a device depends on the supply voltage, it is useful to calculate the voltage
drop from the chain end to the feeding point. In this case, a minimum voltage of 9 V is set to the last device
and the required excitation is calculated. The calculated value should be generously rounded upwards for
guaranteeing a safe operation.

Another fact is the variable internal resistance of the input power supplies (low excitation = lower internal
resistance).

In practice, this means: If the net excitation decreases (e.g. because of a weak power supply or a high
resistivity with long cables), the devices have to readjust to cover the current power requirements. This
causes a higher power consumption, which additionally increases the voltage drop.
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Data logger M-LOG, S-LOG, FLEETIog, IPElog

3 Datalogger M-LOG, S-LOG, FLEETIlog, IPElog

3.1 Overview

Overview properties and options

PC

CPU, RAM on-board (MB)
Real-time operating system
IPETRONIK TESTdrive software

Compact flash data storage medium (removable)

1.8" SSD data storage medium (removable)

Intelligent power management

Interfaces (Hardware)
COM1, COM2

ETH (Ethernet as IPETRONIK system interface)

USB 2.0

DIG IN / DIG OUT

2x CAN High Speed acc. to 11898-2
4x CAN High Speed acc. to 11898-2

2x CAN High Speed acc. to 11898-2 + 2x LIN

1x CAN High Speed acc. to 11898-2 +
1x CAN Single Wire + 2x LIN

2x ETH (Ethernet as measurement input)

Acquire FlexRay data via FlexRay-Ethernet converter

(requires Ethernet input option)
WiFi acc. to 802.11b/g
GPRS/UMTS

Positioning via GPS and NMEA0183
Audio input (standard micro or iMIC)

Video input (USB camera)

Protocols, processes
CCP

KWPonCAN, XCPonCAN
XCPonEthernet

GMLAN

Seed & Key

ubDS

Logger_Manual_V03.51

M-LOG LX  S-LOG FLEETIlog
LX800, 256 @ LX800, 256 LX800, 256
v v v

v v v (>=V3.19)
v v v
v v v
v v —_
v v v
2 2 2
4/4 4/4 2/2
Option Option _—
Option Option v
Option Option _—
Option Option _—
Option Option —_—
External External —_
FLEETIlog
External ¥  External WAN
FLEETIlog
External ?  External ? WAN
FLEETlog
External External WAN
External External —_—
External External —_—
Option Option Option
Option Option Option
Option Option —_—
Option Option —_—
Option Option Option
Option Option Option
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IPElog

Atom, 1024
v

v (>=V3.50

v
v

Option

External

v

External

Option
Option
Option

Option
Option
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Data logger M-LOG, S-LOG, FLEETIog, IPElog

Data acquisition / processing / transferring

Online calculations, different storage groupes v v v v
Statistics, also parallel to time related data Option Option Option Option
Packing, splitting, encoding data v v v v
CANSsend: Data and status signal output via CAN v v v v
WakeOnCAN v v v v
Traffic measurement Option Option Option Option
LOG2PC v v v v
XCP-Service v v v v
Y coMgate or COMgate WAN 2 CcOMgate WAN
Overview properties and options M-LOG LX S-LOG FLEETlog IPElog

Device in general
Excitation all 12/24/42 VDC power supplies v v —_— —

Excitation 9 to 36 VDC v v

Ambient temperature -40 °C to +85 °C
(-40 °F to +185 °F)

Ambient temperature -20 °C to +70 °C
(-4 °F to +158 °F)

Enclosure protection class IP54

<
AN

| AN
AN

ANAANIRN
AN BN
AN

Enclosure protection class IP30
Port replicator selectable

<
<

Removable data storage media
Configuration with IPEconf 4

NNANENENENENEN
NRNENE

<

<

Configuration with IPEmotion

Data transfer range of built-in modems (FLEETIog, IPElog)
Frequency range Quad-Band EGSM 850 /900 / 1800 / 1900
Download rate HSDPA 7,2 Mbps

UMTS/HSDPA (WCDMA/FDD) 2100 MHz

GPRS multi-slot class 12

Edge multi-slot class 12
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Data logger M-LOG, S-LOG, FLEETIog, IPElog

3.2 Hardware
3.2.1 Block diagram

The block diagram shows the basic structure of the logger board.

GV-42Y N Modem-PWR \,._
-
REMOTE y, Suppi M-PWR >
Super q ' =1 GPS-PWR :
% I/0 =g >
%‘:.5 0 Realtime 12C Bus COM 1
fon B = | s
FLASH P 86 UART
NEC X I@ LAN/ W-LAN
| TR
PCI (32 Bit/33MHz) ' USB Keyboard ’
-Bios -USB USB Stick
o
‘M’
Slot 1 Slot 2 Slot 3 —l_m
-« CHN 1 > 1 X-Board -
CHN 2 B <
- DIG OUT 0-3
-« = | ﬁ 4 DIGOUTDS
< CHN3 JZ] o - @D
. CHN4 B o L 8 g g-DIGINDS
- ) T v {0
- CHN 5B (optional) * Sound MIC >
T Headset
Ethemnet (opti CF S >
. ptional) FLASH
st M-LOG
3.2.2 Enclosure types
M-LOG with port replicator PR05 S-LOG front view FLEETIog front and rear view

The M-LOG enclosure is compatible to all M devices. The devices can be easily connected with each other
with a dovetail adapter. M-LOG is available with 6 different port replicators (cable connecting adapter). User
specific port replicators are available on request.

S-LOG uses a SIM standard enclosure and can easily be integrated into a SIM devices system. Both loggers
can be connected to M devices, as well as, to SIM devices (also mixed) with suitable mechanical adapters.

The FLEETIog hardware concept was designed for using the data logger in vehicle fleets, whereas
FLEETIog WAN is already equipped with modem, WiFi client, and GPS receiver.

3.2.3 Portreplicators and cables

Various cables are available for every port replicator. The complete
PIN configuration, as well as, the appropriate cables of the PR05
and PRO8 port replicators are shown in the appendix.
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Data logger M-LOG, S-LOG, FLEETIlog, IPElog

Cable overview M-LOG PRO05 and S-LOG

1 Bus input
600-580.xxx | D-Sub/ S 9 == CAN, open
620-537.xxx | D-Sub/ S 9 == CAN, Banana
620-593.xxx | D-Sub/ S 9 == 2x CAN, D-Sub open
2 M-CAN
620-560.xxx | Lemo OB 9 == M-CAN
620-562.xxx | Lemo OB 9 == SIM-CAN
2 SIM-CAN
600-830.xxx | Lemo 1B 10 == SIM-CAN
600-893.xxx | Lemo 1B 10 angled

— SIM-CAN angled
620-562.xxx | Lemo OB 9 == SIM-CAN
3 Display
620-578.xxx  Lemo 1B 10 — M-VIEWfleet
620-595.xxx | Lemo 1B 10 == M-VIEWgraph
4 Digital input / output
620-324.xxx | D-Sub HD/ P 15 == open
5 COM
620-576.xxx | Sub HD/ S 15 == Modem
620-596.xxx  Sub HD/ S 15 = Modem + GPS
6 Power/Remote
620-574.xxx | Lemo 1B 6 — Banana
7 LAN
620-591.xxx | Lemo OB 6 == Ethernet RJ45
8 Audio
620-550.xxx | Lemo OB 5 == Audio In/Out 3.5mm
620-551.xxx | Lemo OB 5 == Audio In/Out 2.5mm

°0O

System and input cables are also available in different lengths and socket configurations.
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Data logger M-LOG, S-LOG, FLEETIog, IPElog

PIN configuration PRO5 and S-LOG

1 BUS INPUTt
PIN CAN1
CANS5
1 CANS5 - L
2 CAN1-L

3 CAN1/5-GND

4 CAN5 -H

5 Option (Vearrns

CAN5 WakeOnCAN

6 PWR-GND
7 CAN1-H
8 Option (Vearr.in,

CANS5 WakeOnCAN

9 UB-OUT+

2 M-CAN / SIM-CAN

PIN | SIM-CAN
CAN-H
CAN-L
CAN - GND
Status IN

SYNC+
SYNC-
SIM-PWR+
SIM-PWR+
PWR-GND
PWR-GND

© 00 ~NOO U ~AWN PR

(=Y
o

4 DIN / DOUT / LED
DIGITAL IN/OUT

DIN-1
DIN -2
DIN -3

DIN -4
DIN-GND
LOG-PWR
LED — 1 (green)
LED - 2 (yellow)
LED — 3 (redt)
DIN-GND
DOUT -1
DOUT -2
DOUT -3
DOUT -4
DOUT-COM

2 i
5O©O~NO O »wN RS

e~ il el
g~ wN Rk
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CAN 2
CAN 6

CANG6 - L

CAN2 - L
CAN2/6 — GND

CANG6 —H

Option (Vearrns
CAN6 WakeOnCAN
PWR-GND

CAN2 —H

Option (Vearrins
CAN2 WakeOnCAN
UB-OUT+

M-CAN
M-PWR+
M-PWR+
SYNC+
SYNC-

CAN-GND
PWR-GND
PWR-GND
CAN - H
CAN-L

IPETRONIK GmbH & Co. KG

CAN 3 CAN 4
CAN 7 (LIN 1) CAN 8 (LIN 2)
CAN7 - L CANS8 - L
(LIN1-VBAT) (LIN2-VBAT)
CAN3 -L CAN4 - L
CAN3/7 — GND CAN4/8 — GND
(LIN1-GND) (LIN2-GND)
CAN7 —H CAN8 —H
(LIN1 — H) (LIN2 — H)
Option (Veartn, Option (VearTn,
CAN7 WakeOnCAN CAN8 WakeOnCAN
PWR-GND PWR-GND
CAN3 -H CAN4 - H
Option (VearT.in, Option (Vearr.in,
CAN3 WakeOnCAN CAN4 WakeOnCAN
UB-OUT+ UB-OUT+
3 DISPLAY
PIN M-VIEW
1 GPS-PWR
2 Remote-2
3 PWR-GND
4 USB2-DATA- (HOST)
5  USB2-DATA+ (HOST)
6 USB3-DATA- (CLIENT)
7 USB3-DATA+ (CLIENT)
8 USB1-DET
9 USB-GND
10  USB2-PWR (5 V)
5 COM / MODEM / GPS
PIN | Serial
1 COM1 -DCD
2 COM1 - RXD
3 COM1 - TXD
4 COM1 -DTR
5 D-GND
6 COM1 - DSR
7 COM1 - DTS
8 COM1-CTS
9
10 COM2 — RXD
11 COM2 - TXD
12 DGND
13 GPS-PWR
14 MODEM-PWR
15 PWR-GND

ipetronik.com
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Data logger M-LOG, S-LOG, FLEETIog, IPElog

6 PWR / REMOTE LAN 8 AUDIO
PIN PIN Ethernet PIN | Micro/Headphone
1 PWR-IN+ 1 ETH-TX+ 1 MICR-REF
2 PWR-IN+ 2 ETH-TX- 2 MICR-SIG
3 PWR-IN-GND 3 ETH-RX+ 3 | HEADPHONE-GND
4 PWR-IN-GND 4  ETH-RX- 4  MICR-GND
5 IGN. Line 15 5 ETH-GND 5 HEADPHONE
6 REMOTE2 6 PWR-GND
7 MODEM-PWR

3.2.4 Device panel for changing the internal memory card
S-LOG and M-LOG (M-LOG with Upgrade Kit 300) offer a screwed panel for exchanging the cF memory

card if required.

The FLEETIog is equipped with a cF card slot behind the folding front panel.

IPElog has a screwless fixed front panel with open/close contact for exchanging the SSD memory card.

Please note the advice to only change the memory card in exceptional cases because of a
possible intrusion of foreign material, dirt or water into the device and the logger could be
damaged at removing the cF card. The regular data transfer should be done with the USB stick

or the wireless connection (modem or WiFi option).

3.2.5 External fuse for logger protection (IPElog, M-/S-LOG, FLEETIog)

Depending on the number of inputs, capacitor charge, and connected devices (M or SIM

devices, Modem, GPS receiver), the total power consumption (especially at temperatures of —
40 °C / -40 °F) can reach up to approx. 150 Watt. To protect the total system, we recommend
an external overload protection with the following tasks:

» Protection of the supply line in error case
» Overload protection of the current source
» Logger protection.

We recommend using a LittleFuse ATO Fuse Fast Acting Type with a nominal current of 10 A. At using
the maximum charge in ambient temperatures under —40 °C / -40 °F, it can be required to increase the

nominal current to 15 A.

Logger_Manual_V03.51

The individual electric circuits (also see M-LOG Port replicators, S-LOG = PR05) are internally
protected. The internal resistance of multifuse types increases exponentially and limits the
current to a minimum. After clearing the cause of error, the resistance decreases to the normal
value (automatic resetting).

The motherboard fuse does not work reversibly and must be replaced in the case of a required
repair.
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3.2.6 Additional short-circuit protection for IPElog and FLEETIog

As the M-CAN connection is not fused by the logger, we recommend to use the cable M-CAN Cable
M-CAN/PWR-Fuse (No. 620-677.xxx) in order to prevent the logger from damage caused by a short circuit.

5 A regular ATO fuse

3.2.7 LED status display (flashing codes)

LED display

YELLOW

Mode

Ready or
operating

Warning |
Low voltage

Warning Il
Low voltage

Measurement
running

Data medium
access
(post processing)

Data transfer

Error,
Emergency
operation

3.2.8 Power-down at excitation loss

M-LOG, S-LOG, FLEETIog and IPElog are equipped with high-powered capacitors, which guarantee a short
excitation in the case of an excitation loss for regularly shutting the system down without data loss. The
storage capacity of the capacitors depends on several points (e.g. ambient temperature, aging, charge
condition). A data loss can therefore not completely be excluded in the case of a total excitation loss.

Meaning

Device is ready
(Operation: see yellow LED)

The excitation is between 6 V and 9 V. M-
LOG shuts down after 2 minutes at
unchanged status.

The excitation is under 6 V. M-LOG is
buffered by the internal supply and normally
shuts down.

The logger writes the data to the internal
memory.

Prepare file transfer (zip, split)

Transfer files via USB, modem, or WiFi

e.g. at invalid configuration, at less memory
capacity, at emergency shut-down due to
less excitation

A restart is required..

M or SIM devices, which are supplied by M-/S-LOG, FLEETIlog C2 or IPElog, are immediately switched-off at

excitation loss.

We recommend to revise the switching and the buffer capacitors every 2 years for guaranteeing
a clean functionality. The device calibration every 2 years includes this revision.
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3.3 Initial start-up

3.3.1 Connecting the logger

»

Connect the red socket using the
Power/Remote cable (e.g. 620-574.xxx)
with an appropriate power supply

(9 Vg ... 36 Vpe)

PWR+ = Voltage supply Plus
GND = Voltage supply Minus
Shield = Shield or voltage supply Minus

Connect the white socket using the
LAN cable (e.g. 620-591.xxx) with the
Ethernet interface of a PCs/Notebook,
resp. using the LAN cable

(e.g. 620-355.xx) for connection to

a network.

Switch on the logger
REM = Ignition line 15 or power supply Plus via switch
— green status LED lights continuously

Logger starts up and will enter the measurement mode after a short time.
— yellow status LED lights continuously

Refer to the Flow chart of the measuring
process in the appendix for more details.

Useful notes

If the Ethernet connection to the logger will not work properly, at first transfer the correct IP settings to
the logger using an USB stick. Refer to Add logger system, creating test configuration (USB stick).

Using the cable 620-591.xxx LOG Cable ETHERNET (crosslink) is a point-to-point connection
between logger and PC. A fixed IP address is required for both. Refer to Static and dynamic IP
addresses.

When connecting the logger and the PC used for configuration and data acquisition to a network with
DHCP server, both have to be set to dynamic IP address, in order to receive the individual IP address by
the DHCP server automatically.

In this case use cable 620-355.xxx M-LOG PR05 ETH Cable RJ45.

Please consider the risk of IP conflicts (same IP address may exist twice), if you use static IP address
settings when connected to a network with DHCP support.
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3.3.2 Detecting the logger, creating test configuration (Ethernet)
» Start IPEmotion at your PC/Notebook.

I Using Logger Plugln version = 3.50, IPEmotion = 2.0 is required.

» Activate the Plugin IPETRONIK-LOG.

Options > Pluglins > IPETRONIK LOG

I The Plugin IPETRONIK-LOG version 3.50
and higher requires TESTdrive = 3.50 on
the logger. Please update the logger
application if necessary!

» Select the main tab Signals .

» Click Detect to identify the connected
hardware components.
The / all available logger(s) will be displayed in a select list.
Confirm your selection by activating the corresponding checkbox and
click OK. The configuration settings stored on the logger will be readout
and displayed.

» Activate the status signal
CPU load.

> Mark the logger at the left hand
structure top area and scroll the
signal list downwards to CPU load,
hook Active to enable the
checkbox.

» Select ETH from the left hand
tree structure, right click and
choose > Add components

> XCP service from the context
menu

» Select DAQ list slow from the
left hand tree structure, right click
and choose > Add components
> Channels from the context menu

» Mark CPU load and confirm
by clicking OK.
» Mark the logger from the left hand
tree structure top area. Click Start displaying from the tool bar.

» Once the logger has been initialized, the current value of the CPU load is displayed continuously in the
signal list. Now logger's ETH communication test and online data streaming via XCP service has been
completed succesfully.
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3.3.3 Add logger system, creating test configuration (USB stick)

In case the data acquisition or the Ethernet connection is not working properly (e.g. when using obsolete /
former configurations, incompatible IP address settings, ...), we recommend to transfer a valid (already
succefully tested configuration) per USB stick to the logger.

» Create a logger system:
Select from the main tabs
Signals > Add system > e.g.
M-LOG (4CAN)

» Enter the front number of the
logger you will use:
> Mark the logger at the left
hand structure top area and
choose the Extended tab to set
the last four digits of the logger's
serial number using the field
Front number.

» Select the Data manager tab
and activate the check box
Update connection
parameters and click to
Configuration

» Enter valid settings for the IP
address used for the Ethernet
connection (auto IP or fixed IP) as described at Static and dynamic IP addresses.

» Create a test configuration.
» Save the current configuration settings in the project (*.icf).

» Export the project as measurement configuration (TSTdrive.mcf) to an
individual subdirectory located on your Notebook/PC or direct to an
USB stick.

» Unplug the USB stick from the configuration PC.
» Switch on the logger.

» Plug in the USB stick while the logger is running in measurement mode (yellow LED lights). The logger
will stop measurement an start data postprocessing, existing data will be moved to the USB stick. This
process lasts as long as the yellow LED is flashing.

» Then the logger will search for a new measurement configuration on the USB
stick. If a new configruation is found, the application on the logger will be
updated and the origin TSTdrive.mcf on the USB stick is deleted.

»  Wait until the yellow LED lights nor flashes not any longer and unplug the stick.
The logger will switch to measurement operation again.

After all necessary connection parameters have been updated with valid settings (logger, PC), a
communication via the LAN cable is supported, including these actions:

» transfer a new configuration to the logger,
» detect the logger and read the configuration from the logger,

» transfer measurement data from the logger to the PC (import measurement files).
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3.3.4 Static and dynamic IP addresses

Basically IPETRONIK data loggers can be connected to other network clients via Ethernet in two different
ways:

»

Point to point connection between the logger and the PC/Notebook.
Usually neither the logger nor the PC/Notebook supports DHCP (Dynamic Host Configuration Protocol),

it is necessary to set a fixed IP address for both.

Client to client connection between logger and PC/Notebook through a local network. In this case the
network server provides DHCP and manages the automatic IP address assignment to all network clients.
Therefore logger and PC have to use dynamic IP address settings.

Use the Data manager tab to enter
the settings for the logger:

»

Mark the logger at the left hand
tree structure top area.

Select the Data manager tab
from the right hand down area
(configuration tabs).and activate
the check box Update
connection parameters.

Click Configuration.

Choose the tab Medium
selection and activate LAN.

Refer to the dialogs below
for dynamic (Get IP address
automatically) and static IP
address settings.

When using the static IP address
with the logger, it is necessary to
adapt the system control settings
of the PC/Notebook,

For example:
IP address: 192.168.0.100
Subnet mask: 255.255.255.0

IP= Data transfer configuration: 80001707 == ES

Logger_Manual_V03.51

General || Medium selection | LAN

Get IP address automatically: [2}
IF address: |0.0.0.0
Sub net mask: |0.0.0.0
Standard gateway: |0.0.0.0
Preferred DNS server: |0.0.0.0
Alternative DNS server: (0.0.0.0

Speed and duplex mode: | Auto -

Import Export OK Cancel

Settings for dynamic IP adddress

IPETRONIK GmbH & Co. KG

1Pz Data transfer configuration: 80001707

General | Medium selection | LAN

Get IP address automatically: [

IP address:

Sub net mask:
Standard gateway:
Preferred DNS server:
Alternative DNS server:

Speed and duplex mode:

Impart Export

192,168.0.101

255,255.255.0

0.0.0.0

0.0.0.0

0.0.0.0

Auto

oK

Cancel

Settings for static IP address
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3.3.5 Logger system with CAN modules

All IPETRONIK CAN modules (M-Series, SIM-Series, CANpressure, MultiDAQ, High Voltage Iso DAQ ...)
are connected to the data logger with corresponding system cables.

Connecting the modules

» Daisy-chain the modules among one another
and connect the system with its
respective cable to the logger.

» The end of the module chain has to
be terminated with a termination
plug.

» Using M-LOG or S-LOG the 2nd
CAN bus socket has to be
terminated also
> use M-CAN or SIM-CAN
termination plug.

Usually all IPETRONIK CAN modules are connected to the logger through the system
connectors M-CAN resp. SIM-CAN with S-LOG. Thus they can be detected and configured by
IPEmotion in a user-friendly way. Besides this, it is also possible to connect IPETRONK
modules, as well as, non-IPETRONIK CAN modules to a free CAN measurement input.
Please note, that you need a separate cable to supply the modules with power for this.
Configuration of the modules is done manually or by importing a CANdb file.
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Detecting modules, creating test configuration

1. Select the CAN input to which the devices are
connected to (CAN 01 is recommended because
it is connected with the M-CAN or SIM-CAN
socket at the logger).

2. Select Extras from the context menu (right
mouse button).

3. Select Detection to detect the connected
devices and to transfer the current settings to the
configuration.

MMuiltiMAN ic Aatarntad ac IDETDNNIK AN Aavien

» Execute Detection of connected modules as described.

» Configure the modules and the logger (activate channels, set signal
scaling, select sample rates, create storage groups, ...)

» Save the current project.

» Initialize the Logger (working Ethernet connection required) or transfer
the configuration per USB stick to the logger.

To display measurement data acquired by the logger using the Ethernet connection, you have
to add an XCP service at first. Assign all signals to the DAQ lists of the XCP service which you
want to be displayed.

The Options setting Automatic service administration will automatically create an XCP
service and assign all active signals to the DAQ lists.

3.3.6 Access to data stored on the logger
The logger stores all data in a Zip archive on internal storage medium (cF card, resp. SD card with IPElog).
MEA_xxxx.zip measurement data + header file + current configuration

LOG_xxxx.zip logfile with status reports of the data acquisition

A measurement file (archiv file) is empty, if the sum of the file contents calculated from the files
listed below is 0. In this case, the respecitve zip archive will be deleted.

- all files containing storage groups except the DAT files
- all trace files (BD...)

- all statistic files except the DAT files

- Min/Max statistic file (STG)

- Audio/Video files except the DAT files (AVI,WAV,IMG)
- Traffic files (BIN, Quickstart)

- LOG file

- Measurement status file

- PPP debug file (PPP...)

Access (= data transfer to a PC or FTP server) to data stored on the logger is supported:
» per USB stick

» through an Ethernet cable connection

» using COMgate or an internal/external WiFi client

» using COMgate WAN or an internal/external modem
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Using a LAN cable connection

Import measurement files / log files

With USB stick

Select Signals navigation tab.
Select logger in the left Systems
overview.

. Transfer the current data (internal

memory) in the Signals navigation tab to
PC with Import > Measurement files.

. Transfer the current data (internal memory

+ pre-/post-trigger data)) in the Signals
navigation tab to PC with Import >
Measurement files (incl. ring buffer).

. Transfer the current TESTdrive log files in

the Signals navigation tab to PC with
Import > Log files.

Select the target directory or crate a new
folder to save the respective data.

Plug in the USB stick to the running logger. The logger stops data acquisition, saves data, log files and the
related configuration to the stick. If the yellow LED is not permanently on, disconnect the USB stick. The

logger runs now in acquisition mode..

Please note that data can only be imported via USB if no LAN connection to the logger is
activated. Disconnect the logger with the logger context menu.

3.3.7 Synchronizing the logger time
» Mark the logger at the left hand structure top area.

» Right click to the logger entry and select
Extras > Synchronize logger time from the context menu.

Time data of time stamp and log messages have been normalized. Now time stamp output is
local time (former UTC). Time stamps reported in XML files always indicate the offset (time lag)
to UTC time, e.g. <startdate>2012-04-25T09:30:10+01:00</startdate>

In order to ensure a correct time interpretation of recorded data, the IPETRONIK data converter

IPEconverter V02.13 is required.

3.3.8 Updating the measurement application (TESTdrive)
» Copy the file MLogger.rtb (standard) or Logger.prg (for M-VIEWgraph) to the subdirectory named with

the logger's serial number on the USB stick.

» Power up the logger and wait for the yellow LED which indidcates data acqusition.

» Plug in the USB stick to the logger, program update will start automatically.

»  Wait until the yellow LED lights no longer and unplug the USB.

The logger executes a reboot and starts measuring operation with the new application.
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4 External connection

4.1 Grounding

It is absolutely necessary to connect the grounding
of the M-LOG case bottom or S-LOG case rear
with a suitable ground pin within the overall system.
Without this grounding, EMV disturbances and
uncontrolled excitation interferences can restrict
the measuring process.

4.2 Remote connection

! |
|
| 1 2
|
|
: Remote  —< [
|
| A ] g e
I : v'e%icle
|
Power IN + — '
: |
| min.6 Vv (9 V) | al al
| max. 55 V I T - o
| : T PWR
| PowerIN- — | — . o
: I '

The logger has internal buffer capacitors to avoid a data loss due to sudden voltage losses. The
regular shut-down is executed via remote and not by switching-off the excitation!

The activating via a remote impulse (impulse length > 20 ms) is also supported. But the
continuous remote signal must be received within 60 s, otherwise the logger is shut down by
the watchdog.

Example:

Start of measuring system with opening the vehicle door. The continuous remote signal is
received at motor start and the system continues measuring. If the continuous signal is not
received (no motor start), the logger shuts down after 60 s.
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4.3 Digital input/output connection

LOG-PWR switched logger excitation (not stabilized)

The excitation is supplied, as soon as, the logger is activated.

potential free contact with
external excitation up to 42
V without any resistor or
voltage divider

4.3.1 Connecting example digital input
external switch external switch + external switch +
(potential-free) external voltage external voltage
up to 42 V max. above 42V
LOG-PWR : vce
c —0
~
I = 5 MA : vce
1 rd o
TN ~
L DIN-1
|2y | 4 gBIN:%; Additional
r DIN-4 bridge from
| DIN-GND to
(  PWR-GND at o o
DIN-GND PRNN PRN1I GND GND

Terminal 15 of the board
electrics (all vehicle power
supplies up to 42 V without
any resistor or voltage
divider)

The digital inputs are electrically isolated but the respective DIN-GNDs are all connected to one

PIN of the Sub D socket! This PIN has a direct connection to PWR-IN GND with the PR0O3,

PRO04, PRO5, PRO6 port replicators!
The inputs are protected by an internal 5 mA current limitation.

Required minimum values at the input for a clean functionality:
Umin =3V bzw. Ihin =2 mA

4.3.2 Connecting example digital output

external LED or
external relay +
external voltage
up to 42 V max.

external LED, or
external relay
(potential-free)

GND (ground) switched
Ri=20Q

V+ (excitation) switched
Ri=20Q

LOG-PWR
-
~
her 2 30 A N ™ vee
o [ToR] —k—{"1—o
'J DOUT-1
DOUT-2
> &| (DQUT-3
hUAS | LI |:| gooum
[— \_L o]
DOUT-COM | GND
e
.
DIN-GND
external LED, or external LED or
external relay external relay +
(potential-free) external voltage
up to 42 V max.
DIN-GND A\
e 1l
~ ™~
lee = 30 MA GND
o [oR] — B0
1 DOUT-1 N
DOUT-2
> &| (DQUT-3
AUAS | LI |:| gooum
e — \—L o]
DOUT- COM | VCC
e
AY
LOG-PWR

The digital outputs are electrically isolated and can operate bipolarly but the respective COM

ports are all connected to one PIN of the Sub D socket!
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4.3.3 Connecting example external status LED

external LED
(potential-free)
LOG-PWR

LED-1 > green
(LED-2 > yellow)
sz::L’1

(LED-3 > red)
I = 30 MA
e

SMIEEI’IA h X |
DIN-GND\ o~
- CAN input Vehicle
4.4 Bus inputs )
CAN+ N _
4 M CANH
R120 :_':
4.4.1 Connecting example CAN bus CAN- Term-,:
4 CANL
CAN GND
D GND

L— Shield/Chassis
4.4.2 Connecting example LIN bus

Due to the galvanic isolation, the transceiver of the LIN measurement input must be power supplied by an
external source. This can be:

1. Connection of the vehicle’s bus power supply (Vesupply) or

2. Connection of the logger’s power supply (bridge from PIN 5 to PIN 1)

Variant 1: Connect Vp of the external LIN bus

Variant 2: Supply via logger
(bridge from PIN 5 to PIN 1)

Logger_Manual_V03.51

IPETRONIK GmbH & Co. KG ipetronik.com 33/ 123



Configuration with IPEmotion (extract)

5 Configuration with IPEmotion (extract)

The IPEmotion software is required for configuring a logger measuring system and the corresponding
IPETRONIK devices. The software must be installed on the notebook/PC, which is used to configure. (See
the instructions in Commissioning). IPEmotion also supports the online data measurement with using the
XCP service. You can find a detailed description of IPEmotion in the manual, which can be opened in the
software as a PDF.

5.1 First steps
5.1.1 Main dialog

After the start of IPEmotion, the following screen appears.

Main Navigation Tabs Quick Access Bar

~

Main window at selected tab “Signals”

Message window

IPEmotion automatically detects all available hardware connections at starting.

If you want to reduce the required time, select Options > Pluglns for deactivating those
interfaces, which are not used.
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5.1.2 Die Title Bar

The title bar contains the quick access bar, the software name, as well as, a tool bar with the following

functions:

E Help — Open the documentation IPEmotion.pdf where you can find useful information for a

and clean application of the software.

= Minimize — Minimize the application window of IPEmotion and place it in the task bar of your
desktop.
E Maximize — Make the application window visible on your desktop and refit the prior size.

E Close — Close the application of IPEmotion.

5.1.3 The file menu

The file or application menu contains basic functions as: New, Open, Save, Save As,
Runtime version, Print and Close, as well as, further properties such as View,
Options, Support file and About.

The right partial view of the application menu contains a list of the recently used
projects.

The Print function is implemented with limited functionality and not yet localized.

The View function contains the menu points Message window and the Reset
command. Show or hide the message window and reset the displaying configuration to
the default parameters.

5.1.4 Using the options

With the Options entry, you have the ability to edit user defined settings. You can
define the following options:

» Frequently used
» Basic settings
» View

» Data manager

» Analysis
» Units
» Plugins

The following section offers you a detailed overview over the available setting options.
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Frequently used

Activate or deactivate Start with the latest configuration and define the settings for the automatic
hardware detection. Activate or deactivate the automatic hardware detection at start of IPEmotion and
select a possible standard command after successful detection:

» Guided configuration
» Automatic configuration or

» Manual configuration

Basic settings

Select a preferred configuration type:

» Hardware configuration

» Signals configuration

Activate or deactivate the options: Accurate acquisition chain required and Expert mode.

Expert mode

The protocol nodes of imported description files (CANdb, A2L, FIBEX,...) are visible, this

means, the user has access to the signal properties.
With the protocols CCP and XCP the DAQ lists are displayed and can be processed (delete,

move signals).

With the release of IPEmotion V01.07.00 internal channels (-> Variables) for temporary storage
tasks have been implemented. Managing this variables is only supported with an enabled
Expert mode.

Activate the Automatic service administration option to automatically import the active channels into the
DAQ lists of the XCP service. These channels are then available in online view.

Please note the restrictions depending on the Ethernet interface of the PC and the number of
active channels. In this case, it is recommended to manually import the required channels into
the DAQ lists of the XCP service (deactivated Automatic service administration)
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View
Define your view settings according the following listed points:
» Language selection
»  Skin selection
» Displaying tooltips
» Font size of the visual elements

» Transparency of configuration dialogs (0 — 30 percent)

Activate or deactivate the use of the Windows standard dialogs for the file and directory selection.

The Open file dialog is skin-enabled, i.e. it is shown in the selected user interface type.

Language seleckion: |English -
Skin selection: |Blus -

Displaying tooltips: () Fast

(®) Mormal
() OFF
MaL-Pluglns
Font size of the visual elements: -
Transparency of configuration dialogs: 152 %

Use Windaws standard dialags: [

Data manager

Define the Time channel format as Relative or Absolute (This setting is currently not supported for the
export into external formats!) and activate or deactivate the option: Merge time channels with equal
acquisition rate.

P‘ IPEmMOtion options

Time channel format: (@) Relative

() Absalute

Merge time channels with equal acquisition rate: [

Analysis

Select the points per diagram graph. Define if all signals are considered in the analysis diagrams at
drawing the graph or only the samples. Move the bar accordingly to the preferred speed or quality.

P IPEmotion options

Points per diagram graph:

Speed Cuality

Logger_Manual_V03.51 IPETRONIK GmbH & Co. KG ipetronik.com 37/ 123



Configuration with IPEmotion (extract)

Units

Get an overview according the common physical values and their respective unit and edit them.

B IPEmotion options

Phewsical Factor Unik: g~

Mass kg
Time H
Electric current A

Temperature =
MiL-Plugins Molar amount ol Activate this Plugln for all logger
applications.

The corresponding TESTdrive
P ug Ins version must be available at the

. . |
Activate or deactivate the hardware systems to be used. logger!

With the Settings button, you have the ability to define the components (module type and priority, e.g. for
the type selection of the Dry configuration) of the respective hardware system and to edit additional options
settings.

B IPEmotion settings - IPETRO

Compaonents Cptions

Type Prriatity: o

) Mormal i
] LG (4 CAN) High
M-LOG {8 CAN) rormal |
M-LOG (6 CAMN - 2 LIN) Low

i M-LOG (3 CAN - 4 LIM) Mok used

The selection of the hardware components for the configuration by using a signal library is based on the
Priority. This preselection with a priority assignation of the system components facilitates the device
selection and improves the system speed.

The High priority defines a preferred use of the corresponding hardware component at configuring with a
signal library. The hardware components, which are defined with the Not used priority, cannot be selected
for an acquisition.

Logger_Manual_V03.51 IPETRONIK GmbH & Co. KG ipetronik.com 38/ 123



Configuration with IPEmotion (extract)

5.1.5 Creating a support file

With the Support file entry of the application menu, you
have the ability to create a support file and add and/or edit
own comments and error descriptions.

Enter in the appearing Create support file screen an error
description. Accept the default location for the file. To
select another location click on the == symbol.

After you have specified the location and a user defined
file name, click Save to return to the Create support file
screen.

== Create support file E

Description:

File:

oK Cancel

After clicking on OK a zip file is generated that contains the error description, as well as, the following

information:

» System information (Windows version, computer name, free memory on the local drives, ...)

» Current configurations (acquisition, online view, script configurations)

» Trace files (NET, C++)

If you have any problems while working with IPEmotion, send us this support file at

support@ipemotion.com.
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5.1.6 IPEmotion working areas (main navigation tabs)

The main navigation tabs allow a quick activation of the different main functions of IPEmotion. A tab
displayed in light blue indicates an active function.

IPEmotion is designed to follow the main navigation tabs from left to right. Use this reasonable order like a
read thread, which guides you step-by-step to a successful acquisition.

Project Signals

Acquisition | View Data Analysis | Reporting | Scripting | Info
manger

Project
Signals
Acquisition

View

Data manager
Analysis
Reporting
Scripting

Info

Project

Logger_Manual_V03.51

Define your general user defined project data.
Configure the connected acquisition systems and modules.
Configure the desired storage groups and channels.

Take a measurement defined by the connected hardware modules and the set
configurations.

Manage your stored acquired data in all the supported formats.
Visualize your channels with diagrams.

Create reports and project documentations.

Automate your acquisition sequences.

Get a basic overview and general support.
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Signals

Systems

5.1.7 Info

The chapter offers a basic overview of the IPEmotion software. In addition, it shows useful advices and tips
and tricks on how to use IPEmotion.

The view Info is divided into the following menu points:

»
»
»

Logger_Manual_V03.51

Welcome

Release Notes (only in English)
Red thread

Tips and tricks

Keyboard handling
Documentations

Contact and support

Channels

Configuration dialogs
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6 Basic functions

6.1 Switching-on / switching-off

Description of the supported switching-on / switchting-off modes

Remote 1 (Ignition line 15) o
2
z 6 IS 5
O o oo ESao
q).g m.g JCARGIR
55 56 2 o5
S ES g5
xro xr e =ho

Status Measurement running

vy)
(o]
o
=5
=}
(e

Zip, split, encode files

transfer data

(depends on settings)

Follow-up time - Post processing

SW Emergency switch-off
(Communication Timeout)

e R

---4{----=--=---f---------- Ready for operation

| |
: 1
| |
1
! 1
! 2h —P
! == |
HW Emergency switch-off*** [ i 1_
(Power Management) ! !
i — s
Follow-up time * I T
i H | 1
! I 1
e —
Variant t 1 ! i i
Continuous Remote** | i 1 i
—Pi> 20 ms4— | i E___>_1_s____b4' i
Variant 2* 1 | ! i I !
ON pulse + e e i | ———— H— !

Continuous Remote**

Timeout

*Variant 2: Switch-on condition (WakeOnCAN) enabled, continuous remote signal required before timeout expires

**Conitnuous Remote: If a remote signal (duration > 1 s) is identified during post-processing, the logger will stop this task and start a new acquisition.
***HW Emergency switch-off: The logger will be absolutely switched-off by the power management 2 h after the previous falling edge

of the remote signal.

Logger_Manual_V03.51 IPETRONIK GmbH & Co. KG

ipetronik.com

42/ 123



Basic functions

WakeOnCAN, Ignition line 15

Measurement Stop

Remote OFF
(switching-off)

Status Measurement running

== Switching-on
(@]
S
=
(e]

o —
1]
L 5
Y= c
[0 e}
T @
] %]
Emc
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oS o
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Follow-up time - Post processing

SW Emergency switch-off
(Communication Timeout)

2h

HW Emergency switch-off***
(Power Management)

Follow-up time

WakeOnCAN* _—

cmmmmme e oo~ Ready for operation

]

Continuous Remote**  _____

Timeout

*WakeOnCAN Ign. 15: Switch-on condition (WakeOnCAN) enabled, continuous remote signal required before timeout expires

jumper Pin 3-6 and Pin 8-9 at respective CAN input to indicate bus traffic (WakeOnCAN)!

**Conitnuous Remote: If a remote signal (duration > 1 s) is identified during post-processing, the logger will stop this task and start a new acquisition.
**HW Emergency switch-off: The logger will be absolutely switched-off by the power management 2 h after the previous falling edge

WakeOnCAN without
Ignition line 15

Measurement Stop

Ready for operation
Store data,
close files

Switching-off

Status

= Switching-on
(@]
S
=
@

Measurement running

(n —_

)
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(] =
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- [2]
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Post processing

SW Emergency switch-off
(Communication Timeout)

" )
HW Emergency switch-off*** HW Emergency switch-offimactive

-1

-

(Power Management) -

Follow-up time inactive

Follow-up time

WakeOnCAN* —j

Switch-off condition ~  ------------------—-—-—— oo
*WakeOnCAN without Ign. 15: Switch-on condition (WakeOnCAN) enabled,, Switch-off condition configured,,

HW Emergency switch-off and Follow-up time out of operation, Timeout inactive
Jumper Pin 3-6 and Pin 8-9 at respective CAN input to indicate bus traffic (WakeOl
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6.2 Triggering

The logger acquisition program offers 4 trigger conditions for every storage group to control the data
acquisition. The trigger conditions can be deduced from acquired signals, as well as, from calculated
channels. All data is written into the memory (RAM). If a storage condition is met, the data is asynchronously
written from the cache into the open measuring file on the flash card.

6.2.1 Start-trigger

Start of data storage if trigger condition (impulse) is met. Stop of storage with (correct) logger shut-down
(Power down). A defined follow-up time extends the data acquisition for x seconds.

6.2.2 Stop-trigger

Begin of data storage with logger switch-on (Power up). Stop of data storage if trigger condition (impulse) is
met. A defined follow-up time extends the data acquisition for x seconds. If no trigger event is set, data is
recorded until “Remote OFF” or end of the follow-up time.

We recommend to use the function VALID(x ; y) in order to avoid irregular NoValues which
may influence a correct triggering.

Example:
Start-trigger: VALID(,Channel01" > 15; 0) Storage as soon as Channel01 > 15
Stop-trigger: VALID(,Channel01“ > 15, 1) Storage as long as Channel01 > 15
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6.2.3 Start- and Stop-trigger
Begin of data storage if start-trigger condition (impulse) is met. Stop of data storage if stop-trigger condition
(impulse) is met.

A defined follow-up time extends the data acquisition for x seconds. If no stop-trigger event is set, data is
recorded until “Remote OFF” or end of the follow-up time.

6.2.4 Stop is inverted start
Data storage for the time of meeting trigger condition (status).

A defined follow-up time extends the data acquisition for x seconds. If trigger status does not change after
successful trigger condition, data is recorded until “Remote OFF” or end of the follow-up time.

The Follow-up time may not be mistaken for the Post-processing time. Both settings must be
coordinated. The maximum post-processing time is set with Logger > Settings > Data transfer
timeout. This setting limites the switch-on duration after successful “Remote OFF” signal. The
logger is regularly shut down after this time even if the data post-processing (zipping, splitting,
sending) is not yet completed. The post-processing value must be at least 5 min greater than
the currently set follow-up time!
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6.2.5 Save trigger channel

If Save trigger channel is activated, trigger status and some additional information are stored in an implicit
channel (Word data format) in every storage group.

Bit coded information in trigger status channel

Bit No. Description Description (if bit value = 1)
0 Pre-Trigger Pre-trigger time running
1 Between start and stop Trigger signal status

This bit is set during the whole acquisition in Continuous
acquisition mode.

2 Post-trigger Post-trigger time running

3 Trigger Event This bit is set for the time of one signal at every Low > High of the
trigger signal. It is set once at acquisition start in Continuous
acquisition mode.

4 Maneuver Maneuver recording running (No NoValues available anymore)

5 Res Currently not used!!

6 Res Currently not used!

7 Res Currently not used!

8 Res Currently not used!

9 Res Currently not used!

10 Res Currently not used!

11 Res Currently not used!

12 WakeOnCAN WakeOnCAN ist active

13 Power Bad The logger is disconnected from the power supply.

14 Power Good Buffer capacitors loaded

15 KL. 15 Debounced remote signall (terminal 15)

6.3 Storage groups

TESTdrive supports various storage groups to merge signals (direct signals, as well as, calculated channels)
in so-called storage groups. Every storage group can has an own storage rate — independent from the signal
rate. This storage rate is valid for all signals in the group, i.e. the signal is detected with the set sampling rate
and recorded with the storage rate.

The maximum storage rate of a group is defined by the signal with the highest sampling rate.
The frequency for online calculations corresponds to the highest sampling rate in the calculation.

Every storage group can has own trigger conditions (see Triggering). Selected signals can be detected with
a high storage rate if required, e.g. in case of a specific event.
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6.3.1 Storage group

Storage group

General | Settings | Triggering

Storage rate:

Time stamp channel:
MoValues:
Save trigger channel:

Prefix:

Storage rate

Time stamp channel

Logger_Manual_V03.51

(]

=

O O

Selection of a fixed storage rate or a channel related storage rate (From channel).
Using the setting From channel means, .the channel with the highest sample rate

wn e

COpS

Select Signals navigation tab.

Select Storage groups.

Select Add component > Storage
group from the tab menu or the context
menu (right mouse button).

Enter a name and a description in the
General tab.

Activate the storage group

Select Add component > Channels
from the tab menu or the context menu
(right mouse button).

Select the signals and confirm with OK.
Define additional parameters with
Settings und Triggering.

Ring buffer group

General | Settings | Triggering
Storage rate: From channel -
Time stamp channel:
MNoValues:
Save trigger channel:
Prefic: []
Ring buffer

Ring buffer size: |1s

within the storage group will determine the storage rate.

The measuring data contain the absolute time channel (logger time).
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NoValue

Save trigger channel

Ring buffer size

The NoValue between the trigger events, which is defined in the respective chan-
nel, is added with Format.

The trigger status channel is added to the storage group and recorded. This
channel contains additional information, which is saved with the single bits in the
data set.

Defines the size of the ring buffer for measuring. If the max ring buffer size is
reached, the memory is overwritten beginning with the oldest data.

Use the ring buffer group to record data, which is only required in case of a specific event, e.g.
error case. Define how many data is recorded before and after the event with the pre-trigger
and post-trigger. Please note that relevant data can also be overwritten depending on data rate
and storage duration!

6.3.2 Trigger settings

Mode

Pre-trigger duration
Post-trigger duration
Start-trigger
Stop-trigger

Scaling

Select the trigger mode from Continuous acquisition (no trigger), Start-trigger,
Stop-trigger, Start- and Stop-trigger, Stop as inverted start (see Triggering)

Data recorded before the trigger event

Data recorded after the trigger event

Value, which starts the data storage of the respective group.
Value, which stops the data storage of the respective group.

Triggering the physical value or the raw value of the numerical value calculated
with the formula.

Define the triggering conditions as formula from the system signals and calculated signals. You
can optimize your data recording with a clever configuration of storage groups and triggering
conditions to record signals at a high storage rate only if required. This method reduces the
data volume, saves memory, and facilitates the final analysis!

Logger_Manual_V03.51
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7 Standard functions

7.1 Calculations

TESTdrive supports the online calculation of the signals acquired in the system. The desired calculation is
defined with the corresponding software dialog — manually or with the formula editor.

IPEmotion Version 1.03 and Plugin IPETRONIK-LOG = V03.20 offer a shared formula editor, i.e. the
following calculation functions are available in IPEmotion, as well as, in TESTdrive.

Calculations, which are based on each other, must be run in the same cycle rate to get a
correct result! If, e.g., the result of a calculation with low cycle rate is used in a calculation with
higher cycle rate, a time offset results, which can influence the result according to a signal
change (amplitude). In that case, the signal sampling rate of the first calculation must be raised.

The formula editor requires the use of the semicolon “;” instead of the comma “,” as variable

separator.

If a value within a calculation is “NoValue®, the calculation result is “Novalue*, too.

7.1.1 Mathematic functions and operations

1 Basic operation
Operator Name Syntax Example Result
+ Addition “Temp01“ + “Temp02“ 15+ 10 25
- Subtraction “Temp01” - “Temp02“ 15-10 5
* Multiplication “Temp01* * “Temp02“ 15*10 150
/ Division “Temp01“/ “Temp02“ 15/10 15
MOD Modulo, Division rest “Temp01“ MOD “Temp02“ 15 MOD 10 5
ABS()  Absolute value of a number ABS(“Temp01“) ABS(-15) 15
SIGN()  Sign of a number SIGN(“Temp01") SIGN(15) 1
SIGN(0) 0
SIGN(-15) -1
NEG() Negation of a number NEG(“Temp01) NEG(15) -15
NEG(-15) 15
( Begin bracket term (“Temp01* + “Temp02“) *2  (15+ 10)* 2 50
) End bracket term (“Temp01“ - “Temp02*)*2  (15-10)*2 10
2 Power, Square root, Exponential and Logarithm functions
Function Name Syntax Example Result
A Power “Temp01“ ~ 2 1572 225
SQRT() Square root SQRT(“Temp01*) SQRT(25) 5
EXP() | Exponential function of basis e EXP(“Temp01*) EXP(5) 148.41
LOG() Logarithm of basis 10 LOG(“Temp01") LOG(5) 0,4771
LN() Logarithm of basis e LN(“Temp01*) LN(5) 1.0986
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3 Trigonometric functions, Hyperbola functions
Function Name Range of values in radiant
SIN() Sine +/-3.99 rad
COS() Cosine +/-3.99 rad
TAN() Tangent +/-3.99 rad
ASIN() Arc sine +/-1.0 rad
ACOS() Arc cosine +/-1.0 rad
ATAN() Arc tangent +/-1.0 rad
SINH() Sine Hyperbolicus +/-1.99 rad
COSH() Cosine Hyperbolicus +/-1.99 rad
TANH() Tangent Hyperbolicus +/-1.99 rad
4 Comparative operations (comparison of variable values)
Function Name Syntax Example
= Equal “Temp01“ = “Temp02“ 15=10
15=15
<> Unequal “Temp01“ <> “Temp02“ 15<>10
15<>15
< Less than “Temp01* < “Temp02* 10< 15
15< 15
> Greater than “Temp01* > “Temp02“ 15> 10
15> 16
<= Less than or “Temp01” <= “Temp02* 10 <=15
equal 15<=15
20 <= 15
>= Greater than or  “Temp01“ >= “Temp02“ 15>=10
equal 15>=15
15>=20
IF(;;)  Iffunction IF(“Temp01“ >= “Temp02“; X; y) x=1y=0
“Temp01“ =15
Query to a specific status. “Temp02“ = 10
If Occurrence > action 1, otherwise action 2 “Temp01“ = 10
Example: IF(“Thermo_channel3" > 30; 1; 0) “Temp02“ = 15
If Temperature > 30, Result: 1 otherwise 0
Action 1 and 2 can also be calculations.
5 Logic operations (comparison of signal states)
Function Name Syntax Example
AND And “Temp0l1“ > “Temp02“ AND “Temp01“>10 15>5
15> 10
10>5
OR Or “Temp01“ > “Temp02" OR “Temp01“ > 10 15>5
10>5
10> 10
XOR Exclusiv or “Temp01® > “Temp02“ XOR “Temp01“>10 15>5
10>5
15> 15
10> 10
NOT() | Not NOT(“Temp01“ > “Temp02“) 15>5
(inverse state) 15> 15
5>15

Logger_Manual_V03.51
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6 Boolean operations (bitwise comparison of signal states)
Function Name Description Example Result
ANDB | And bitwise | Bits which are set in operandl and in 27 ANB 12 8
operand2 will be set in the result 11011 ANDB 01100 01000
(bit = 1), all others will be not set (bit = 0)
ORB Or bitwise Bits which are set in operandl or in 26 ORB 8 26
operand2 will be set in the result 11010 ORB 01000 11010
(bit = 1), all others will be not set (bit = 0) 27 ORB 13 31
11011 ORB 01101 11111
XORB | Exclusive or | Bits which are set only in operandl or only 26 XORB 8 18
bitwise in operand2 will be set in the result 11010 XORB 01000 10010
(bit = 1), all others will be not set (bit = 0) 27 XORB 13 22
11011 XORB 01101 10110
NOTB | Not bitwise Bits which are set in operandl will be not  NOTB 27 4
set in the result (bit = 0), all others willbe  NOTB 11011 00100
set (bit = 1)
7 Statistic functions
Function Name Syntax , Description Example Result
MIN() Minimum MIN(“Temp01*) 4]112]3|25]| 17 3
MAX() Maximum MAX(“Temp01“) 411232517 25
MEAN() | Average Average from all valid values
MEAN( ;) Average from Average from n valid values
n values
MINOR( ;) Less value MINOR(“Temp01“; “Temp02) 4112 4
MAJOR( ;) | Greater value MAJOR(“Temp01“; “Temp02) 4112 12
FLOOR() | Round integer FLOOR(“Temp01") 13,72 13
off
CEIL() Round integer CEIL(“Temp01") 13,41 14
up
ROUND() | Roundinteger ROUND(“Temp01“) 13,41 13
13,72 14
LIN(;;;) Linearization @ LIN(“TempO1“;
X hode-1;y node-1;
X hode-n; y node-n)
Runs a linearization with the defined
nodes. Betweenn=2and n = 16
nodes can be defined.
8 Other functions
Function Description
EDGE_POS() Detect positive edge
1 if current value is > 0 and the previous one <=0
EDGE_NEG() Detect negative edge

1 if current value is <= 0 and the previous one > 0
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Function
DIFF()

INT()
INT_UP()
PREV()

(, Templ* +
(PREV (, Temp1l"))
+ (PREV
(PREV(, Temp1l)))
)/3
SHL(;)
SHR( ;)

TESTBIT(;)

TESTMASKS( ;)

TIME( )

TIMER(; )

VALID()

VALID(X; y)

Logger_Manual_V03.51

Description

Runs a differentiation of an operand acc.to:
(Opri(t) — Opl(t-1)) * DeltaT

Calculates the integral of an operand acc. to:
"((Opl(t) + Opi(t-1))/2) * DeltaT"

Calculates the upper integral of an operand acc.
to: "Op1(t) * DeltaT"

Outputs the previous value.

Floating average from the current value and both
previous values

Shift value bitwise to the left.
Shift value bitwise to the right.

Checks the value (0, 1) of the defined bit. If the
bit described by operand 2 is set, result = 1,
otherwise result =0

(Counting order starting left hand with 0)

Makes a comparison with a user definable
bitmask. If at least one bit is set in operand 1 and
also in operand 2, result = 1, otherwise result = 0
TIME(“Temp01)

A counter that adds the time intervalls of the
corresponding sample rate continuously and
outputs the sum as long as the operator's value
is>=0.5

In case the operator's value is < 0.5, the counter
is reseted and O is output.

If no new value is received from the channel
defined as Parameterl within the timeout
(Parameter?2 in seconds), the output value is '1'.
Check for validity

Example Result
PREV(“Temp01“) 4 |
121325 NV [12]3
1SHL 2 4
001 SHL 2 100
12 SHR 1 6
1100 SHR 2 0110
TESTBIT(1101; 3) 1
TESTBIT(1101; 1) 0
TESTMASKS(27, 6) 1
TESTMASKS(27, 4) 0

1 if value is unequal to NoValue, O if value is NoValue

Avoid Novalues

x if value is unequal to NoValue, y if value is NoValue

IPETRONIK GmbH & Co. KG
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7.1.2 Constants

9 Constants

Constant
Pl
SYSTEMRATE

SYSTEMTIME

SAMPLERATE
SAMPLETIME

7.1.3 NoValue control

Description

Pi > 11 = 3.141592654 ...

TESTdrive internally works with a fix system rate. This rate depends on
the configuration (Channel with highest sampling rate) and can be used
for calculations. The system rate can be compared with the timer ticks of
a PC clock and is set in Hz.

The system rate relates to the working frequency of the PC/Notebook (=
Frequency of the High-Performance-Counter).

Reciprocal value of the system rate (=1/SYSTEMRATE) and is set in
seconds.

Please note at using a system rate in the MHz range that the system time
can only be correctly displayed if sufficient decimals have been defined
and Automatic has been selected in Display > Formatting.

Channel sample rate in Hz
Channel acquisition intervall in 1/s

Example:
Signal scaling 8 Bit integer signed

A NoValue alarm can be activated for every signal Range -128 ... 0 ... 127

within the Format tab.

General | Format | Scaling || Display | Thermo
Data type

Type: |16-Bit integer signed

MoValue [ DefaultValue

Value: |IETH=E

Channel type Tl
+rullScale

NoValue setting = -FullScale
With a signal value of -128 the expression
NoValue will be written to the data record.

Limit value . .
With an activated check box, the
expression -FullScale will be written to the
- Task: [Mathing data record

= | []Deactivate MoValue and use Default Value

s

Input:

The timeout setting is defined at:

IPEmotion Options > Basic settings > Expert mode >

e

= BExpert settings E

=

View protocols:

Expert settings Edit protocol channel scaling: [
If the timeout expires without any signal value, the entry Inore verbal tables: []
NoValue resp. the selected standard value ist output for Variable configuration:

display and data record. A status message is written to

the log file.

O

Reference configuration:

Extended tabs:

&

If a M-VIEWvga is used, this message must be confirmed.

Logger_Manual_V03.51

O

Additional warnings:
Maximum size of acquisition data files: | 100 MB
Mo value timeout: |2|

5
Legging import: I,}

0K Cancel

IPETRONIK GmbH & Co. KG ipetronik.com 53/ 123



Standard functions

7.1.4

Calculation examples

Greater comparison , >*

Syntax >

Description  Compares the current value (of a channel or a calculation) with a user defined constant or

variable. The result is 1, as long as the comparison is true, otherwise the result is 0 (for a
false comparison).

Example ».Channel01“ > 2 Comparison with a constant

Constant

Signal

Results

»,Channel01“ > ,Channel02" Comparison with a variable

4

Variable

Signal

Result

—
Time

4

Less

Time

comparison , <"

Syntax <

Description  Compares the current value (of a channel or a calculation) with a user defined constant or

variable. The result is 1, as long as the comparison is true, otherwise the result is 0 (for a
false comparison).

Example .Channel01 < 2 Comparison with a constant

Constant

Signal

Result

.Channel01" < ,Channel02“ Comparison with a variable

Variable

Signal

Result

Time

-

4

Time
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Counter (without reset)

Syntax

Description

Example

Tip

~counter01” + x
VALID(“Counter01”; 0) + x

Counts continuously with the current sample rate, i.e. the counter value is increased by x
with each sample. The rise of the counter slope depends on the currently configured
sampling rate and the counter step. A measurement stop resets the counter to 0.

Accumulates 1 with each sample

~counter01“ = ,Counter01“ + 1
= Accumulates 10 with each sample

,Counter01“ = ,Counter01“ + 10

Used with TESTdrive (logger application) this recursive formula will result in valid values as
the initial value for variables is set automatically. Used with IPEmotion (Acquisition >
Calculations > Formulas) the respective formula has to be completed with the Valid function:
»counter01“ = VALID(,Counter01“; 0) + 1

The Valid function sets the initial counter value to a defined value (here 0) in case the current
value is invalid.

Counter with counting condition

Syntax

Description

Beispiel

Tip

Counter

Constant
Signal

Trigger

IF(“Channel01” > x; ,Counter01“ +vy; ,Counter01")
IF(“Channel01” > x; VALID(* Counter01”; 0) +y; VALID(“ Counter01”; 0))

Counts continuously with the current sample rate, as long as, the current value of
"Channel01" is greater than x. The counter value is increased by y with each sample, as long
as "Channel01" fulfills the condition. Otherwise the counter remains unchanged. As son as
the condition is fulfilled again, the counter continues with the previous value. The rise of the
counter slope depends on the currently configured sampling rate and the counter step.

A measurement stop resets the counter to 0.

.Counter01" = IF(“Channel01” > 5; "Counter01“ + 1; ,Counter01“)
Accumulates 1 with each sample as long as "Channel01" is greater than 5.
Stop counting and holding the latest value, as soon as ,,Channel01“ is less than 5.

Used with TESTdrive (logger application) this recursive formula will result in valid values as
the initial value for variables is set automatically. Used with IPEmotion (Acquisition >
Calculations > Formulas) the respective formula has to be completed with the Valid function.

»

Logger_Manual_V03.51
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Counter with counting condition and reset

Syntax

Description

Beispiel

Tip

Counter

Constant
Signal

Trigger

IF(“Channel01” > x; , Counter01“ +vy; 0)
IF(“Channel0l1” > x; VALID(“Counter01”; 0) +vy; 0)

Counts continuously with the current sample rate, as long as, the current value of
"Channel01" is greater than x. The counter value is increased by y with each sample, as long
as "Channel01" fulfills the condition. Otherwise the counter will be reset to 0. As son as the
condition is fulfilled again, the counter restarts with 0. The rise of the counter slope depends
on the currently configured sampling rate and the counter step.

A measurement stop resets the counter to 0.

»counter01" = IF(“Channel01” > 5; ,Counter01“ + 1; 0)
Accumulates 1 with each sample as long as "Channel01" is greater than 5.
Stop counting and reset to 0, as soon as ,Channel01“ is less than 5.

Used with TESTdrive (logger application) this recursive formula will result in valid values as
the initial value for variables is set automatically. Used with IPEmotion (Acquisition >
Calculations > Formulas) the respective formula has to be completed with the Valid function.

»

T >
10 20 30 40 50 60 Sampling time

Validation check , VALID*

Syntax

Description

Example

Tip

Logger_Manual_V03.51

VALID(x)
VALID(X;y)

VALID checks the current value (of a channel or a calculation) for validity, i.e. if the variable's
status is ,invalid“ (NoValue).

With the VALID(x) function the result is1, as long as x is valid and changes to 0, as soon as
the x has the status NoValue.

With the VALID(x;y) function the result is x as long as x is a valid value. As soon as x will be
an invalid value (NoValue) the result changes to y. In case y is a variable (instead of a
constant) the result of VALID(x,y) will be NoValue, as soon as x, as well as, y are an invalid
value.

VALID(,Channel01*) 1 if ,Channel01 s NoValue, 0 if ,Channel01* = NoValue
VALID(,Channel01%4) ,Channel01*if ,Channel01* =|= NoValue, 4 if ,Channel01" = NoValue

When using a measurement value within a recursive formula (x = x + y) we recommend to
use the VALID(x; y) function in order to avoid invalid values (NoValue). Even if the
measurement signal becomes valid values, the recursive formula will not be calculated
correctly, once a NoValue occurred.

We recommend to use the VALID(X; y) function for any signal which serves as a trigger for a
storage group. An invalid trigger signal could prevent the start of the data storage even if the
trigger signal will become temporarily valid.

IPETRONIK GmbH & Co. KG ipetronik.com 56/ 123



Standard functions

Mean value (averaging) ,, MEAN*
Syntax MEAN(x)
MEAN(X; n)

Description  MEAN(x) continuously calculates the moving average from all valid measurement values.
MEAN(x; n) berechnet continuously calculates the moving average from n previous
measurement values.

Example MEAN(,Channel01") moving average from all values of a measurement
MEAN(,Channel01; 10) moving average from 10 values at a time
Tip The diagram shows the differences of the MEAN functions with a rectangle signal
(clock 5 Hz)
Square red origin signal
Mean Square blue  moving average
Mean_5 Square green moving average from 10 values at a time
1 -
0,84
0,6
0,4
0,2
D |
0 1 2 2 4 g & 7 [sl] g 10 11 1 13 14 15
— Sguare — Mean Sguare . —— Mean_5 Square

Linearization , LIN“
Syntax LIN(Operand; x-Node01; y-Node01; x-Node02; y-Node02)

Description  Runs a linearization with user defined nodes. Between n = 2 and n = 16 nodes can be
defined. The scaled values (Y-axis) are calculated from the original measurement values (X-
axis) using factor and offset of the partial linear slope between two nodes.

Example LIN(,Channel01“; 0;-0,5; 2;1; 4;2; 8;2,5)

Tip The linearization enables a non-linear scaling (multipart scaling) used for physical graphs
without having a mathematical equation.
Using this multipart scaling an approximation of a mathematical equation is more precise as
more nodes are used.
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7.1.5 Local calculation

| )

wn e

Select Signals navigation tab.

Select Local calculations.

Select Add component >
Calculation from the tab menu or the
context menu (right mouse button).
Activate the calculation.

Enter a name and a description in the
General tab.

Enter the calculation in the Formula
tab.

Calculation rule: 80002367

Enter the calculation formula
manually or use the Formula editor

().

8. Move signals and operators in the
entry field by using Drag&Drop.
9. Confirm with OK.
10. Enter the value range and the
decimals in the Display tab.
11. Define additional limit values and/or a
NoValue.
T

"DIN 017 OR "DIN 027

Py

Operand Description Reference Source Operator
:DIN 01 ; (

DIN 02 Define external trigger (e.g... |DIM 02/800... | 2/DIN/200 )

DIM 03 Define external trigger (e.q... DIM 03/800... | 3/DIN/&00 I+

DIMN 04 Define external trigger (e.g... |DIM 04/800... | 4/DIN/200 i

DOUT 01 Digital output DOUT 01/8... | 1/DOUT/E *

DOUT 02 Digital output DOUT 02/8... | 2/DOUT/a0 -

DOUT 03 Digital output DOUT 03/8... | 3/DOUT/8E !

DOoUT 04 Digital output DOUT 04/8... |4/DOUT/S0 w | | MOD

1] n | 3 ABS()

Define external trigger {e.q. for a storage group).

Poal

Description

Begin of bracket blodk
End of bracket block
Addition

Subtraction
Multiplication
Potentiation

Division

Modulo operator
Absolute value

=
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7.2 Digital inputs and outputs
7.2.1 Digital inputs

Activate the Signals tab.

Select DIN in the system overview.

Activate the desired digital inputs.

Enter a name and a description in the

General tab.

5. Enter the value to be interpreted as NoValue
in the Format tab. (Value out of the valid
range)

6. Enter the value range and the decimals in
the Display tab.

7. Define the lower and upper limit value with
Limit value.

8. Enter the output/display of invalid value with

NoValue.

PoObdE

7.2.2 Digital outputs : :
Activate the Signals tab.

Select DOUT in the system overview.

Activate the desired digital outputs.

Enter a name and a description in the

General tab.

Enter the value to be interpreted as NoValue

in the Format tab. (Value out of the valid

range)

6. Enter the upper and lower acquisition range
with Scaling.

7. Enter the value range and the decimals in
the Display tab.

8. Define a formula to control the output with
Calculation.

9. Define the lower and upper limit value with

Limit value.

SO

Gl

Logger_Manual_V03.51 IPETRONIK GmbH & Co. KG ipetronik.com 59/ 123



Standard functions

Sampling rate DOUT

The logger's digital outputs (DOUT) support
a definable sampling rate (cycle rate) of up Active:
to 100 Hz. Mame: |DOUT 01

Description: |DeFine a command to activate the digital output,

' General ][ Farmat " Sealing ” Displary ” Calculation ” Frequency output ” Lirnit walue

Reference: |M1-L0G (4 CAN)

Sampling rate: 10 Hz
1Hz
ZHz
5 Hz
Frequency output DOUT 20Hz
S0Hz
If the frequency output is activated, a square 100k
wave voltage is sent. The signal frequency _
can be configured. | Gemeral " Farmat " Scaling " Display " Calculation ” Frequency output
Frequency oukpuk ackive:
F =

7.3 OBD-2 measurement

With releases of the Plugin IPETRONIK-LOG / TESTdrive = V03.22 data acquisition using the OBD2
standard (CAN bus) supported.

The OBD-II international standard details a list of 96 predefined signals and measurement parameters which
makes it easy to acquire provided operating data by a data acquisition system. This standard is mandatory
for petrol engine cars since 2001 respective diesel engine cars since 2003 and trucks since 2005.
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7.4 WakeOnCAN

The WakeOnCAN function switches the logger on as soon as the respective CAN bus is active, i.e. when
messages are transferred.

7.4.1 ON via WakeOnCAN, OFF via Ignition 15

If there is no Switch-off time configured, the remote signal (e.g. terminal 15) must be active within the set
timeout to permanently switch-on the logger. The logger is turned off if the remote signal is not received after
the timeout. The logger stays in operation mode as long as the remote signal is high. As soon as remote is
low, the Follow-up time will start and the logger is switched-off when datat postprocessing is finished.

Bridge Pin 3 (CAN2/6-GND) > Pin 6 (PWR-GND) General | Extended | System | Data manager
Bridge Pin 8 (WaOnCAN) > Pin 9 (UB-OUT+) St e {88 eomE

Timeaut: |1 min

Depending on the CAN card/Port replicator, the
WakeOnCAN function supports

only at CAN 2,

at CAN 2 and CAN 3

at all CAN inputs (special version)!

7.4.2 ON via WakeOnCAN, OFF via Switch-off condition

With a configured Switch-off condition the Timeout setting has no influence. The logger stays in operation
mode as long as the Switch-off condition is false.

General Extended | System | Data manager

Switch-on condition (WwakeonCAaR): Sitch-off condition: "DINOL" =1 CFlh

Timeouk: |1 min

If a temporary remote signal (duration > 1 s) is identified in this mode, the Follow-up time starts
with the falling signal edge and the logger is switched off (when postprocessing is finished),
even with a false Switch-off condition.
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7.5 Output signals via CAN

Status signals

Status signals can be used in one configuration in the same way
as measuring channels. Status signals can be added, e.g., into
calculations, triggers or storage groups.

Requirement: CAN board with FPGA version > 1.04.00

CAN Send

A CAN input in a logger configuration can be used to send CAN
data.

Any data can be sent (also values from calculations or status
signals). The information about the signals to be sent can be
exported with CANdb.

At least one CAN participant must be connected to the CAN
interface to transfer data to the CAN. If this is not the case,
TESTdrive sends the following error:

E Error sending CAN message in CANSendWorkStation. Counter = 1
Options
Start CAN ID:

Enter a start ID. The first signal uses this CAN ID, any further signal gets an ID raised by one. If the sending
counter is activated, it is ouput at the start ID.

» TESTdrive 3.11 supports maximum one channel (=signal) per ID.
»  With TESTdrive 3.13 several channels can be assigned to one ID.
» It won't be possible to define one ID for a specific channel.

» Itis possible to use Extended ID.

Send rate:

It is possible to define the send rate.

The following settings are permitted: 0.5/ 1/ 2/ 5/ 10/ 20/ 50/ 100 Hz

If the send rate is greater than or equal to the source channel rate, the following message is written into the
TESTdrive3 log file:

D ERROR in CCANSendWorkStation::Put() Fifo full!
Send counter:

If the send counter is activated, a 32 bit value beginning from 0 is incremented for every send cycle and
output at the start ID. All channels are moved for one ID.

Example:

Start ID = 256

Name - 1D -- Value
1% cycle:

Send counter -- 256 -- 0
Channel_1 -- 257 -- 0.01
Channel_2 -- 258 -- 0.08
2" cycle:

Send counter -- 256 -- 1
Channel_1 -- 257 -- 0.12
Channel_2 -- 258 -- 0.23
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7.6 Log file output via Hyperterminal

The logger status messages can be displayed online with a RS232 PC or notebook connection. The
MLOG.ht file is copied into the following directory:

C:\Documents and Settings\[user]\Startmenu\Programs\Accessories\Communikation\
HyperTerminal\....

Prior to this, a hyperterminal connection must be created.

Or create a new hyperterminal connection:

Connection Description

Enter a name and choose an icon for the connection:

Mame:

M-LOG] |
lcon:
: e =)
|
[ Ok H Cancel ]

The following components are required for the
connection of M-LOG and PC: @

for PCs with serial interface: Al diese seiingel P <~

1 x USB to RS232 converter / N

1 x Null modem cable /
1 x Gender Changer " \‘
for PCs without serial interface: 1 1
2 x USB to RS232 converter \ !
1 x Null modem cable ' /

1 x Gender Changer

The components for PCs without serial interface are S o -
available as an optional package (M-LOG-OPT-086).
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7.7 Send e-mail with status information

If this function is activated and the logger has an internet connection (LAN, WiFi, modem), it sends a status
e-mail after acquisition stop with the following content:

- serial number and number of the current acquisition in subject line
- attached log file

- attached measurement status file if activated

- attached STG file (Min-Max list) if activated

P& Data transfer configuration

General | Medium selection | LAM | E-mail Select the logger in system overview.
Activate the Data management tab.
Activate the Update connection

File encoding: [ parameters > Configuration to change

the settings for data transfer configuration.

Emergency switch-off after: |1 h -

wh P

SR R e P ssviort 4. Select Activate e-mail delivery.
Activate data remate transfer, [ 5. Define the corresponding setting in the E-
Mail tab.

Time synchronisation via SMTP: O

Ackivate e-mail delivery:

Import Export ok Cancel

configuration

General | Medium selection | LAN | E-mai
To:
Subject: |Logger [SerialMumber]: Measurement no, {MeasurementId} finished
From;

Lagger: [SerialMumber]OMeasurement: {MeasurementId} Oatkachment: {Attachment}

Setver setkings

Server [P address: |0.0.0.0 Authentication: [
Seryver name: Lser:
Password:
Impark Expark oK Cancel
To E-mail address of recipient
Subject Subiject line for serial number and mesaurement number file
From E-mail address of sender (any text)
Description field Description of serial number, measurement file number and attachement
Server |IP address IPE address of outgoing mail server (to e-mail account,
e.g. smtp.mail.proivder.com) for sending
Server name Alternative input of server name of outgoing mail server
Authentication Access authorization to user e-mail account
User User name
Password Password
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7.8 Output messages to CAN/LIN

With the Logger Plugin V03.21.00 / TESTdrive 3.21 and higher an output of user defined messages to CAN
bus or LIN bus is supported.

The output timing can be selected from:
- one-time, at start measurement,
- one-time, at stop measurement,
- cyclical every x ms.

An external file with the *.DAT extension is used to configure the settings for the messages.
A sample file is available from:
c:\Programs\IPETRONIK\IPEmotion Plugin IPETRONIK LOG V03.xx.xx\Data\Channel.dat

The header of this files contains detailed information regarding to the usage of the parameters.

The screenshots below show the implementation of the external file in IPEmotion configuration.

Skatistic
External programs

Event handling

Tultiple selection. ..

|
k] W g TN

1. Select Data processing in the left
Systems overview.

2. Select Add components > External
programs from the tab menu or from the
context menu.

3. The new entry External programs has
been added to Data processing.

& Runtime library

Multiple selection. ..

4. Select External programs in the left
Systems overview.

5. Select Add components > External
programs from the tab menu or from the
context menu.

6. Chose additional settings in the tab
Extended.
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General | Extended

External library: |6678\DatavChanneldccess.dim (==e Remove
Configuration file: | Build 16678DatalChannel, dat === Remove

Extended (Runtime library)
Message cyvcle time: (10 ms -
External library

File location of the external application (DLM)

Configuration file
File location of the configuration (DAT)

Message cycle time
Ouput rate of the message (repetition rate)

Example Offset adjust for IPETRONIK modules connected to the logger’s CAN input

The message output feature offers the possibility to broadcast an offset adjust command to IPETRONIK

CAN modules with adjust function.

The sample file OffAddStart.dat contains the adjust commands for task Manual and Group 1-4.

The sample shows a manual adjust on CAN 01 with a baud rate of 500 kBit/s, executed with a time delay of

2.5 seconds from start measurement.

Brief description of the parameters (see header of the sample Channel.dat for detailed settings):
/I Hardware initialization <---Basic setting of CAN/LIN input

[Init]

/I Channel, ChnType, Chnindex, ChnMode, Baudrate

CANO, 1, 0, 1, 500000
<--mee- ChnType LIN=2 /CAN=1, Chnindex Nr 0...11=Input , ChnMode 29Bit=2 11Bit=1/ Baud rate

/I List of messages (send/receive)

[Messages]

// Name, ID, Length Bytes <------ ID CAN/LIN -ID; Length= Number of bytes; Bytes = Message
/)

Manuell 1, 0x0, 8, 0x00, 0x91, 0x02, 0xCA, 0x3F, 0x00, 0x80, 0x80 <----Manual
Manuell_2, 0x0, 8, 0x00, 0x91, 0x02, 0xCA, 0x3F, 0x00, 0xCO0, 0x81

Manuell_3, 0x0, 8, 0x00, 0x91, 0x02, 0xCA, 0x3F, 0x00, 0x40, 0x8C

Manuell_4, 0x0, 8, 0x00, 0x91, 0x02, 0xCA, 0x3F, 0x00, 0xCO0, 0x8D

Manuell_5, 0x0, 8, 0x00, 0x91, 0x02, 0XxCA, 0x3F, 0x00, 0x00, Ox8E

Groupl 1, 0x0, 8, 0x00, 0x91, 0x02, 0xC5, 0x3F, 0x00, 0x80, 0x80 <-----Group 1
Groupl 2, 0x0, 8, 0x00, 0x91, 0x02, 0xC5, 0x3F, 0x00, 0xCO0, 0x81

Groupl_3, 0x0, 8, 0x00, 0x91, 0x02, 0xC5, 0x3F, 0x00, 0x40, 0x8C

Groupl_4, 0x0, 8, 0x00, 0x91, 0x02, 0xC5, 0x3F, 0x00, 0xCO, 0x8D

Groupl_5, 0x0, 8, 0x00, 0x91, 0x02, 0xC5, 0x3F, 0x00, 0x00, OX8E

Group2_1, 0x0, 8, 0x00, 0x91, 0x02, 0xC6, 0x3F, 0x00, 0x80, 0x80 <-----Group 2
Group2_2, 0x0, 8, 0x00, 0x91, 0x02, 0xC6, 0x3F, 0x00, 0xCO, 0x81

Group2_3, 0x0, 8, 0x00, 0x91, 0x02, 0xC6, 0x3F, 0x00, 0x40, 0x8C

Group2_4, 0x0, 8, 0x00, 0x91, 0x02, 0xC6, 0x3F, 0x00, 0xCO, 0x8D

Group2_5, 0x0, 8, 0x00, 0x91, 0x02, 0xC6, 0x3F, 0x00, 0x00, OXx8E

Group3_1, 0x0, 8, 0x00, 0x91, 0x02, 0xC7, 0x3F, 0x00, 0x80, 0x80 <-----Group 3
Group3_2, 0x0, 8, 0x00, 0x91, 0x02, 0xC7, 0x3F, 0x00, OxCO, 0x81

Group3_3, 0x0, 8, 0x00, 0x91, 0x02, 0xC7, 0x3F, 0x00, 0x40, Ox8C

Group3_4, 0x0, 8, 0x00, 0x91, 0x02, 0xC7, 0x3F, 0x00, OxCO, 0x8D

Group3_5, 0x0, 8, 0x00, 0x91, 0x02, 0xC7, 0x3F, 0x00, 0x00, OX8E

Group4_1, 0x0, 8, 0x00, 0x91, 0x02, 0xC8, 0x3F, 0x00, 0x80, 0x80 <-----Group 4
Group4_2, 0x0, 8, 0x00, 0x91, 0x02, 0xC8, 0x3F, 0x00, OxCO0, 0x81

Group4_3, 0x0, 8, 0x00, 0x91, 0x02, 0xC8, 0x3F, 0x00, 0x40, 0x8C

Group4_4, 0x0, 8, 0x00, 0x91, 0x02, 0xC8, 0x3F, 0x00, 0xCO0, 0x8D

Group4_5, 0x0, 8, 0x00, 0x91, 0x02, 0xC8, 0x3F, 0x00, 0x00, Ox8E
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[Conditions]
/I Name Condition

/ Messages which have to be send at measurement start <---- The output sequence is defined by the
sequence of the list

[OnStart]

/I Time, Channel, Message

2500000, CANO, Manuell_1

<-- 2500000 ps after Start /CAN input/ To adjust a group, replace with Group1_1
2500000, CANO, Manuell_2

<-- 2500000 ps after Start /CAN input/ To adjust a group, replace with Group1 2
2500000, CANO, Manuell_3

<-- 2500000 ps after Start /CAN input/ To adjust a group, replace with Group1_3
2500000, CANO, Manuell_4

<-- 2500000 ps after Start /CAN input/ To adjust a group, replace with Groupl1_4

2500000, CANO, Manuell_5
<-- 2500000 ps after Start /CAN input/ To adjust a group, replace with Group1_5

Refer to the header of the *.DAT file for further parameter settings.

7.9 Event controlled measurement
7.9.1 Possibilities for data acquisition

For measurement signal acquisition and storage in electronic systems, analog signals need to be digitalized,
first. This is done by taking discrete measuring values from the continuous signal sequence (Sample & Hold)
and recording them cyclically. Cyclic recording is also used for native digital signals, e.g. for measuring data
packages from bus systems.

For some applications, it is useful to not record CAN bus data cyclically but event-controlled.

In the following, the basic features of both data acquisition types are described.
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7.9.2 Cyclic data recording of continuous signals

Features of cyclic data recording (Plugin IPETRONIK-LOG)

» time-based recording in a fixed time grid, e.g. sampling rate 100 Hz

» different storage groups allow different data rates for recording

» individual time channel for each storage group in measurement data set

» continuous recording in equidistant intervals

» suitable for analog signals

» improved time accuracy due to increased sampling rate (oversampling)

» clear comparability of different signals using a synchronization clock (Master Sample Clock MSC)
» protocol measurement during data acquisition using bus systems is possible (CCP, XCP, FlexRay, ... )
» bus signals are allocated to the respective time grid (sampling rate)

» (time) differentiation of two signals is not possible in the time grid

» sampling points without real signal value are indicated with "NoValue" (invalid) in data set
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7.9.3 Event-controlled data recording of bus signals
Sample graph

Features of event-controlled data recording (Plugin IPETRONIK-LOG)

» event-controlled recording without fixed time grid for bus signals, e.g. CAN bus

» all signals of a message are provided with an exact time stamp, as with traffic measurement
» individual time channel for each message in measurement data set

» discontinuous recording without defined time grid

» suitable for measurement of bus signal differences and of sporadic or single signals

» measuring values in different messages feature different time stamps > in the result graph, the time
stamps do not lie on the same x-values any more

» no protocol measurement possible (CCP, XCP; FlexRay, ...)
» determination of exact time difference between signals (difference between time stamps)

» "NoValue" entries indicating the absence of signals are avoided
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7.9.4 Setting up event-controlled data recording (Plugin IPETRONIK-LOG)
General

Event-controlled measurement, available from TESTdrive 3.51.00 onwards, features the benefits of signal
measurement and traffic measurement:

Signal selection is already interpreted (name, scaling, unit,...). Yet, measurement is not performed cyclically
but with "real" time stamp. Signals are only recorded if they really are present on the CAN bus. Using the
exact time stamp.

Event-controlled measurement appears like a signal measurement on the configuration surface and in the
measurement file. Loggers process the respective storage groups in traffic measurement mode.

Configuration settings

The respective signals must not be recorded cyclically.
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In the storage group, the storage rate has to be set From channel. It should not be a fixed storage rate.

As a result, sampling rate is Event controlled and storage rate is Auto.
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Measurement file

Event-based signals are recorded in an event-based storage group TS_xxxxxx.DAT. A signal-based storage
group DOxxxxxx.DAT with cyclic storage rate cannot contain event-based signals since event-controlled or
cyclic recording types are properties of signals and not of storage groups.

There are two types DAT files:

+c:A\Temp\BAD-IP_26 80900023 20130629 114253 MEA 1813.ZIP\".

»  DOxxxxxx.DAT for storage groups with

. N . . 2 £ E| g

CyC|IC storage rate and S|gnals with fixed, BAD-IP_26_80900023_20130629_114253_02_Loggerstatus_D0021813 DAT  20.90(
: i BAD-P_26_80900023_20130629_114253_02_| oggerstatus_D0O021813 18 5890
CyC"C Samplmg rate BAD-IP_26_80900023_20130629_114253_02_L oggerstatus_D0D21813 T64 47161
- BAD-IP_26_80900023_20130629_114253_02_| opgerstatus_DD021613 W16 353 761
by TSxxxxxx.DAT for storage groups with BAD-IP_26_80900023_20130629_114253_02_| ongerstatus_DO021813 w32 14150
LT . | BAD-IP_26_80900023_20130629_114253_02_L oggerstatus_D{1021513 Wi 5306
event-controlled, non'CyC"C S|gna|5 without | BAD-IP_26_80900023_20130629_114253_03_Fahrzeugstatus_DO021813 DAT  B7.08
: i || BADAP_26_80900023_20130629_114253_03_Fahizeugstatus_DO0I31613 116 4
fixed Samp“ng rate BAD-IF_26_80900023_20130629_114253_03_Fahzeugstatus_DO031813 R32 4
BAD-IP_26_80900023_20130629_114253_03_Fahizeugstatus_D0031813 T64 3
BAD-IP_26_80900023_20130629_114253_03_Fahizeugstatus_DD031813 W16 2
BAD-IP_26_80900023_20130629_114253_03_Fahizeugstatus_D0031613 w3z 4
. BAD-IP_26_80900023_20130629_114253_03_Fahizeugstatus_D0031813 we 431
Conclusions - BRDT - T T eI aRe SeE e :
| BAD-IP_26_80900023_20130629_114253_04_Vollumfang_getriggert_DO041813 116 l
» Each message that is recorded event- || BAD-IP_26_80900023_20130629_114253_04_VYollumfang_getriggert_D0O041813 A32 1
. A X | BAD-IP_26_80900023_20130629_114253_04_Vollumfang_getriggert_DO041813 T64 l
controlled receives an individual time | BAD-IP_26_B0900023_20130629_114253_04_Vollumfang_getriggert_DO041813 Wi1G 1
channel (| BAD-IP_26_80900023_20130629_114253_04_Vollumfang_getriggert_DO041813 w32 l
|| BAD-IP_26_80900023_20130629_114253_04_Vollumfang_getriggert_DO041813 we 1
| BAD-IP_26_80900023_20130629_114253_05_GPS_D0051813 DAT  6.85
» In DAT format of the |ogger measurement _'|BAD-IP_26_80900023_20130629_114253_05_GPS_DO0S1813 R32 43541
X (| BAD-IP_26_80900023_20130629_114253_05_GPS_D0051813 T4 12.441
each message creates an own internal _'|BAD-IP_26_80900023_20130629_114253_05_GPS_DO0S1813 W16 18.661
BAD-IP_26_80900023_20130629_114253_05_GPS_D0051813 w32 6.22
storage group (TSXXXXXX-DAT) E]BAD-lP_zs_suauuuzs_zm30523_114253_us_ﬂmdnetz_nuus1313 DAT  10.56
(| BAD-IP_26_80900023_20130629_114253_06_Bordnetz_DO0G1813 116 47.60:
» In order to ensure strong system || BAD-IP_26_80900023_20130629_114253_06_Bordnetz_DO0G1813 T64 G347
L || BAD-IP_26_80900023_20130629_114253_06_Bordnetz_DO061813 w32 31.731
performance, it is useful to check the | BAD-IP_26_80900023_20130629_114253_06_Bordnetz_DOOG1813 w8 119.011
_ H (| BAD-IP_26_80900023_20130629_114253_07_IPEspeed_komplett_DO071813 DAT  21.58:
number of event-controlled measuring | BAD-IP_26_80900023_20130629_114253_07_IPEspeed_komplett_DO071813 R32 1.702.27
signa|s according to the app“cation || BADP_26_80900023_20130629_114253_07_IPEspeed_komplett_D0071813 TE4  141.85(
| BAD-IP_26_80900023_20130629_114253_07_IPEspeed_komplett_DO071813 W16 106.39;
(necessary number of storage grou ps). | BAD-IP_26_80900023_20130629_114253_07_IPEspeed_komplett_DO071813 Wiz 70,92
| BAD-IP_26_80900023_20130629_114253_07_IPEspeed_komplett_DO071813 W8 425561
(| BAD-IP_26_80900023_20130629_114253_08_T emperaturen_Motorraum_DO081813 DAT  6.93(
|| BAD-IP_26_80900023_20130629_114253_08_T emperaturen_Motorraum_DO081813 116 94.331

(| BAD-IP_26_80900023_20130629_114253_08_T emperaturen_Motorraum_D0081813 T64  47.160
Measurement data set | BAD-IP_26_80900023_20130629_114253_08_Temperaturen_Motorraum_DO081813 w32 2358

" BAD-IP_26 80900023 20130629 114253 08 Temperaturen Motonaum DO0Z1813 we

. . . BAD-IP_26_80900023_20130629_114253 09_Ereignisgesteusrt TSO10001813 DAT  2.02
In table view, it becomes obvious that || BAD-IP_26_80900023_20130629_114253_09_Ereignisgesleuert_T50100071813 R3? 70.36
; f [ BAD-IF_26_80900023 20130629_114253 09_Ereignisgesteuert_ TSO10001513 Wed 140,721
time intervals are not eQU|d|Stant any more and JE;m:v-lF*_zra_zw.muuzs_zun306;39_11azsa_mzq_nz.eagn;sgmtme.u_TsmUrm813 DAT 2.0
messages (signals) are no more identical. Each BAD-IP_26_80900023_20130629_114253 09 Ereignisgesteusrt_T5010011813 R3Z  70.34
. . . BAD-IP_26_80900023_20130629_114253_09_E reignisgesteuert_TS010011813 W64 140691
value is measured and saved at the time it BADIP_26 80900023 20130629 114253 09 Ereignisgesteuert TS010021813 DAT  2.02

BAD-IP_26_80900023_20130629_114253_09_Freignisgesteuert_T5010021813 R32 72191
aCtua"y occurs on the CAN bus. | "IBADIP 26 80900023 20130629 114253 09 Ercianisacstouert TS010021813 W4 14439

Indes; | Time Speed_mph_3 Time Speed_mph_2 Time Speed_mph_1
BAD-IP_26_8090,., |BAD-IP_26_80900023_... BAD-IP_26_80... EBAD-IP_26_809000... B&D-IP_26_8... BAD-IP_26_s09000...
4934 240,595994 2,931 71491622925 248, 95334 Z,76157086105347 247,835911 Z,41663070539550
4935 240,97948 2,93171491622925 247,033392 Z2,76187056105347 247, 655266 2,41663070539556
4936 240,999118 2,53171491622925 247,084021 2,76187086105347 247,735998 2,53171491622925
4937 241,079566 2,41663670539856 247123429 2,76187056105347 247,765547 2,761870586105347
4935 241,095935 2,41603670539556 247,173719 Z,64679265022275 247,545152 2,76187050105547
4939 241,179301 2,41663670539356 247,223519 Z,B46792E5022275 247, 55555 2,53171491622925
4940 241,260063 2,30155897140503 247,273564 2,64679265022275 247945201 2,18643099523292
4941 241,259621 2,301555971405035 247, 323497 Z,6467926502227E 247, 995492 2,15643099599292
4942 241,315031 2,30155897140503 247, 373656 Z,B46792E5022275 248,055395 2,18643099599292
4943 241,389505 2,30155897140503 247,423454 2,64679265022278 248,085545 2,41663670539856
4944 241,41812 2,301555971405035 247,4730355 Z, 6467926502275 248, 145236 2,9317 1491622925
4945 241 ,459517 2, 1564509959929 247,5234z2 Z,64679265022275 246, 155475 2,30155597 140503
4945 241,5058455 2,186430995399292 247,573539 2,53171491622925 248,245249 2,18648099599292
4947 241,579502 2, 1564509959929 247,62349 2,531 71491622925 248, 285752 2,30155597 140503
4945 241,605423 2, 1564509959929z 24767366 Z,593171491622925 2485, 345459 Z,41663070539556
4949 241,679551 2, 1864309959929 247, 723447 2,53171491622925 248,388511 2,41663670539556
4950 241,705274 2, 07140302655051 247, 773024 2,531 71491622925 248, 445397 Z,41663070539550
4951 241,779567 2,071403026550651 247,623407 Z,53171491622925 245, 45574 2,93171491622925
4952 241,3058086 2,07140302658081 247,873659 2,53171491622925 248,545416 2,64679265022278
4953 241,579497 2,071403026580581 247,923452 2,41663670539354 248,565424 2,67694853346558
4954 241,905254 2,07140302655051 247,9730353 Z,41663070539556 245,635553 3,107 10477525979
4955 241,979364 2,07140302658051 248,033872 2,41 663670539856 248,655354 3,45233845710754
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7.9.5 Practical example: Determination of the latency of two signals
Task

An electronic system (ECU) receives messages via CAN bus (input signals) and sends them out again on
the CAN bus, e.g. as forwarding or after calculation (output signals).

Processing time = response time of the system is to be determined.

Realization

The response time results from the time difference between input and respective output signal. Since both
incoming and outgoing CAN messages are provided with a time stamp, the exact time difference can be
determined through event-controlled measurement.

Advantages:
» No event gets lost (not fixed to a sampling rate or to several signals within one sampling interval).
» Unique time stamps from TESTdrive are used.
» Event-controlled measurement is based on traffic measurement > traffic group.

» Each ID generates an event with a new signal value.
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8 Options (license required)

8.1 Hardware options (internal)

M-LOG and S-LOG can be extended by 3 slots with different IPETRONIK cards. Max. 3 cards can be

combined depending on the assignment to the extension slots and the port replicator. The active CAN cards

support a highly accurate 1 ps time stamp. This time stamp is synchronous for all inputs within a card.

8.1.1 CAN cards

The following CAN cards with galvanically isolated high speed inputs acc. to ISO 11898-2 and low speed
acc.to 1ISO 11992-1 are available:

»
4
4

2 x CAN High Speed, WakeOnCAN functionality, active data preprocessing and message buffer
4 x CAN High Speed, WakeOnCAN functionality, active data preprocessing and message buffer

3 x CAN High Speed, WakeOnCAN functionality, active data preprocessing and message buffer
+ 1 x CAN Low Speed (5 V, fault-olerant)

3 x CAN High Speed, WakeOnCAN functionality, active data preprocessing and message buffer
+ 1 x CAN Low Speed (24 V)

8.1.2 CAN/LIN cards

The following CAN LIN combination cards with galvanically isolated inputs are available:

»

2 x CAN High Speed, WakeOnCAN functionality, active data preprocessing and message buffer
+ 2 x LIN

2 x CAN Single Wire (GMW 3089 V2.1) + 2 x LIN

1 x CAN Single Wire (GMW 3089 V2.1) + 1 x CAN High Speed, WakeOnCAN functionality, active data

preprocessing and message buffer + 2 x LIN

8.1.3 Ethernet cards

The following ETH card with galvanically isolated inputs is available:

»

2 x ETH 10/100 MBIt LAN, e.g. as input via XCPonEthernet or FlexRay-Ethernet converter
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8.2 Software options

8.2.1 Import signal description files

IPEmotion supports the import and management of signal descriptions from CANdb (*.dbc), ASAP2 files
(*.a2l), and diagnostic description files (*.idf).

The contents are read and managed by importing the original files into a database (Microsoft SQL-Server).
The original files are therefore not longer required. Please note at updating the CAN system or the control
unit that the current description file must be reloaded to update signal descriptions, if required. An export of
the signal settings changed with IPEmotion into the original description file is not possible.

Import data from a description file: CANdb
(*.dbc), ASAP2 (.a2l), LINdb (*.Idf)

Select a CAN input (here CAN 01).

Select Import from the tool bar.

Select the directory and the type of the

decsription file to open.

dbc defines CANdb files

a2l defines ASAP2 files

Idf defines LINdb files (LIN Description File)

4. Toimport an A2L file, select the
communication protocol first

5. Confirm with OK.

6. The imported signals (Pool) are displayed in

atable.

wphpE

General signals at CAN 01 cannot be configured if CAN 01 is already used for IPETRONIK
devices!

Importing signal descriptions from ASAP2 or CANdb is the easiest and most secure method to
configure signals.

Signals can also be manually created at an input (without description file). Select Add
components > Standard CAN from the tool bar within the Signals navigation tab.
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Import CANdb file
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Import signal descriptions from the CANdb

Signals in data source

Logger_Manual_V03.51

Select signal Properties of highlighted
signal (Front_right)
IPETRONIK GmbH & Co. KG ipetronik.com
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Import ASAP file

= Select protocol == ES

Several protocols can be imported from the description
file, Please select the protocol to work with,

CCP : 14 signals
KWP on CAN : 14 signals
KCPonCAM : 14 signals
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Import signal descriptions from A2L

Signals in data source Select signal

Properties of highlighted
signal (Front_right)

CCP protocol settings

Resume active

The ECU can be disconnected and and reconnected to
the CAN bus. Data acquisition is continued after
reinitialization.

Seed & Key

Authentication procedure used for restricted access to
ECUs. A program file provided by the ECU manufacturer
is required to proof access authority.

EPK check
Compares the checksums of the configuration (A2L file)
with the respective sums stored with the ECU.

Use optional commands

Enables optional commands provided by the ECU.
Commands are listed in the A2L file and make the
communication more comfortable.
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Import Diagnostic file

Logger_Manual_V03.51 IPETRONIK GmbH & Co. KG ipetronik.com 80/ 123



Options (license required)

8.2.2 Detection mode and cycle rate
. 10 ms sync event channel
Pollin g 100 ms sync event channel

Polling functionality is supported by A2L for CCP and XCP, i.e. no DAQ lists are seq sync event channel
required.

IPEmotion offers three different speeds for data requests. The times are reference values because the
values must be individually requested at the control unit and create a high bus load.

SLOW 1000 ms MIDDLE 100 ms FAST 10 ms

Example:  If 5 values are detected in the SLOW polling mode, the 1* value is requested by the control unit
a 2" time after approx. 6 s.

DAQ list or polling?

Communication via CCP protocol takes place by sending the data cyclically or triggered by an
event after the first inquiry. The send rate is defined in the respective DAQ list, e.g. 10 ms, 100
ms or synchronous to an event. Not all control units support this mode or the DAQ lists are not
included in the A2L file. In this case, the signals can be sampled individually with the polling
mode. But this method causes a much higher bus load and therefore longer response times.

8.2.3 Traffic acquisition

The CAN traffic acquisition (also CAN-Trace) allows high-capacitive recording of CAN messages (total bus
traffic) with the CAN controller of each measuring input. Due to the fact that a huge amount of data can result
from this method within a short time, data acquisition can be restricted with 20 definable admission filters.

Every input has 2 ID trigger to control the traffic acquisition start.
Filters and triggers

With selecting the respective branch, the available filters are displayed in a table. You can now define the ID
areas of the CAN messages, which are saved at meeting one of the trigger conditions.

2 ID triggers are available within the traffic properties in the dialog. As soon as one of the trigger conditions is
met (OR operation), all filtered CAN messages of the CAN inputs are saved. A condition can be defined for
every data byte within the ID trigger (= CAN message). Only if all conditions are met (AND operation), the
trigger is activated.

Data format and conversion

Traffic data is saved in a binary file with header (description) and the actual data, e.g. TD001234.bin. To
generally use the data (e.g. import in CANalyzer), data is converted into the ASCII format with the data
converter.

Use the IPETRONIK data converter version 2.xx IPEconverter WIN with graphical user interface (requires a
license ) or the version with the command line IPEconverter CMD (no license required).

The software, as well as, the documentation are saved at the IPETRONIK CD:

..\IPETRONIK_SoftwareProducts\Tools\DataConverter\...

Logger_Manual_V03.51 IPETRONIK GmbH & Co. KG ipetronik.com 81/ 123



Options (license required)

Configuring traffic acquisition

1. Select a CAN input (CAN 02).

2. Select Traffic recording from the main
menu Add components or with the
context menu and right mouse button.

3. Now the tree structure shows the new arm
Traffic recording at the respective CAN
input.

4. Select Filter and/or ID-Trigger from the
main menu Add components or with the
context menu and right mouse button to
restrict the recording to the required data.

Name First CAM ID [hex] | Active | Last CAMIQ\ [hex] | Description -
7
a | 7ff | Admission filter for reducing the data volume
Filter 02 a O 7ff | Admission filter for reducing the data volume
Filter 03 a | 7ff | Admission filter for reducing the data volume
Filter 04 a O Admission filter for reducing the data volume
Filter 05 a | Admission filter for reducing the data volume
Filter 06 a O Admission filter for reducing the data volume
Filter 07 a | Admission filter for reduding the data volume | _
Name Active | Description | First CAM ID [hex] | Last CAN ID [hex] | Operator for Byte 1 | Value for Byte 1 [hex] | Data for Byte 1 [hex]
v
[] | ID-Trigger 3 a | Off 0 f
ID-Trigger 02 | [ | ID-Trigger a a|off 0 ff
ID-Trigger 03 | [ |ID-Trigger a a|Off 0 ff
ID-Trigger 04 | [ |ID-Trigger 3 a|Off 0 f
ID-Trigger 05 | [] |ID-Trigger 3 a | Off 0 f
ID-Trigger 06 | [] | ID-Trigger a a|off 0 i
4] m | 3
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8.2.4 Statistics calculation

The frequency of signals is counted and evaluated with classifications. To do so, the acquisition range is
divided into equal (equidistant) zones (classes). The current values is assigned to one class at every
sampling and the frequency is counted (see figure).

Class Measuring signal Table Classification

‘ 4

‘ 5

Ol N | W NN OB
N

V1| / \ [V EE
: | Y [V °
1 v v ’° .
1 2 3 4 5 6
to T Frequency
Advantages Disadvantages

Much less storage required than with a time No original value
related acquisition

Very suitable for statistical analyses (e.g. life  No time reference of the signal
cycle tests)

Classification methods

Different classification methods have been developed in the past whereof IPETRONIK supports the most
common methods (acc. to DIN 45667, FVA sheet):

» Random sampling counting

» Level crossing counting

» From-To counting

» Edge counting

» Rainflow method (available upon request)

Please find further information in the Classification.pdf document (Classifying with KIM/KAR and DIS) on the
IPETRONIK CD or at the FTP info server.

Requirements

Hardware M-LOG, S-LOG, FLEETIlog, IPElog
Configuration IPEmotion
Software TESTdrive V03.06 or V03.18 (IPEmotion) or V03.50 (IPElog) or higher

It is recommended to use the latest software version for guaranteeing a clean functionality of all
components..
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Configuring statistic / classification

1st Step Creating configuration
» Start IPEmotion and load an existing configuration or create a new configuration.

» Import the corresponding signal descriptions (CANdb or ASAP2) and/or configure additional
IPETRONIK devices.

» Activate the desired inputs and run the required scaling.

» Select a sampling rate or accept the default sampling rate. Please note that the sampling rate, which is
selectable in the classification, cannot be higher than the maximum sampling rate.

2nd Step Defining storage group (if time related data is also required)

» Create a new storage group with Storage groups and the context menu
Add components to also record the time related signals.

»  Assign the desired signals to the corresponding storage group.

3rd Step Defining classification

» Select Data processing in the system structure and select Statistic
from the main menu Add components or with right mouse button
> context menu.

» Select Statistic in the system structure and select Components >
Channel from the main menu or with right mouse button > context menu
to create channels.

» Define additional classification settings within the tabs General,
Settings, and Trigger.

Reset behaviour Data is written into a new classification
file at changing the configuration or at
starting acquisition.

Sampling rate Data storage rate of classification

Trigger (Statistik) General trigger, defines start- and stop- v
trigger, value range 0/ 1

Classification

Name any name for classification
Mode selected classification method
General | Settings | Trigger
Trigger defines start- and stop-trigger of the active Mode: [Random sample dassficaion~

channel (classification start and stop

From-Tao

Edge counting

Level crossing counting
Rainflow

Time at level
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8.2.5 Operating in FTP mode (terminal server)

TESTdrive version 3.09.00 allows starting M-LOG as FTP server. Data can easily be transmitted with a FTP
software (e.g. Total Commander or WS_FTP). Depending on the user rights, data can additionally be
deleted or written. A separate USB flash drive incl. TESTdriveCmd.xml file is required for this functionality.
The running acquisition is stopped and the log file saved with connecting the USB.

If the TESTdriveCmd.xml file includes the "StartFTPServer" OnConnect job, there is no post processing.
TESTdrive reads the corresponding parameters and starts the FTP server.

Server access requires the following user data:
Version User Password Access rights
Vv03.09.00 guest none Read to TO directory

A reboot is automatically running at connecting USB flash drive to correctly stop the service as FTP server.

Procedure:
1. Switch-on M-LOG
2. Connect USB flash drive with TESTdriveCmd.xml
3. Connect Ethernet cable between M-LOG and PC, e.g. 600-591.xxx (M-LOG PRO05, S-LOG)
4. Configure network settings of PC, create additional "Alternative configuration"
User defined
IP address: 192.168.0.1 (Example)

Total Commander settings: Server name: 192.168.0.2, Enter user name and password

8.2.6 Recording audio and video data

Recording video data

Data logger supports recording video or single shots with a camera. The camera is connected to the logger
USB port.

Following settings are available:

Resolution Defines the image quality
"Low" 160 x 120 Pixel (B x H) 30/20/10/5 images per second
"Medium" 320 x 240 Pixel (B x H) 30/20/10/5 images per second
"High” 432 x 240 Pixel (B x H) 30/20/10/5 images per second

Max. recording timeDefines the recording duration
Frame rate Defines the number of images per second

All three options directly influence the required memory.

Trigger A trigger condition must be defined to start recording.
Trigger mode Triggering to raw data or scaled values

Raw Triggering to raw data

Phys. Triggering to physical values (acc. to scaling)
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Recording audio data

Data logger (M-LOG, S-LOG) supports recording audio signals (sounds, speech) with a microphone at the
audio input.

Following settings are available:
Bit rate Defines the audio signal quality
22050 Bit/s (FM radio), 11025 Bit/s (AM radio), 8000 Bit/s (Phone quality)
Max. recording timeDefines the recording duration
Both options directly influence the required memory.
Trigger A trigger condition must be defined to start recording.

Trigger mode Triggering to raw data (Raw) or scaled values (Phys)

8.2.7 UDS protocol (Unified Diagnostic Services)

UDS protocol combines KWP2000, GMLAN, and DiagnosticOnCan in one protocol. An advantage is the
clear session handling (higher compatibility of different control units). Furthermore, UDS supports modern
memory structures, which require a > 32 Bit addressing.

The corresponding description file has the ODX extension.

Control units of some manufacturers already support UDS, which will be used as standard diagnostic in near
future.

Jobs overview
TESTdrive V03.15 supports the following jobs, which can be read via UDS:

» FS_READ

» FS_READ_DETAIL

» IDENT

» READ_DATA REFERENCE
» FG_READ

» DYNAMICALLY_DEFINE_LOCAL_ID

These jobs can be defined with an *.idf file.

Storing data

The results are optionally stored as binary file (*.CSV and *.J**) or as trace and binary file (*.CSV, *.J** and
* T,

The files are identified as follows:

Single data detected via KWPonCAN: BDKxxxx.CSV bzw. BDKxxxx.Jxx
(former description) BDJIxxxx.CSV bzw. BDSxxxx.Jxx
UDS data detected via trace mode: BDUXXXX.txx

Selecting protocol

The UDS protocol is selected with the corresponding tab in the import module.
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8.3 Recording GPS-Data

The GPS receiver GPS 18 and the NMEA protocol option, M-LOG, S-LOG, as well as, FLEETlog WAN with
integrated GPS receiver support the continuous recording of GPS data with the global satellite navigation

system. This functionality allows positioning and logging of test routes with a data rate of 1 Hz.

Marne Active Unit Phiys Min
7 (=]

GPS status ] ]

GPS latitude O | -3, 4E+36
GPS longitude O e -3,4E+35
GPS speed O  [kmfh |-3,4E+38
GPS altitude O |m -3,4E+38
GP3 satellites number O -3, 4E+5E

4
General | Format | Display | Limit valoe | Movaloe
Ackive: [
Marme: |GPS precision
Descripkion: | Precision
Reference:

Sampling rate: 1 Hz

Fhiys Ma

1

3,4E+35
3,4E+38
3,4E+35
3,4E+35
3,4E+35

Predefined settings are available to configure the acquisition. The single channels are activated as required.

The accuracy of the positioning data is considerably defined by the number of received

satellites (12 satelites are in the geostationary orbit).

Due to physics, the accuracy of the height acquisition (Altitude) with this method is considerably

lower than that of the length acquisition (Latitude = geographical width, Longitude =
geographical length).
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8.4 Remote data transfer

The logger offers the availability of wireless data transfer by corresponding options. Single vehicles, as well
as, entire vehicle fleets can be managed from one or several bases. Due to the worldwide good to excellent
GSM network coverage, regional and global test drives can be managed from any base.

8.4.1 Transferring data using GPRS and Internet to FTP server

GPRS3G/CDMA + Internet

|
|
|
\\\ — User 1
Upload v
current configuration —
+ mesurement data ( ) —
( ) —
|
\\\ — User 2
Download
new —
confi guration —
|
- User 3
Node point of the Internet Server/ PC with
GSM network server internet access

Components
» M-LOG, S-LOG, FLEETlog WAN, IPElog

» M-LOG, S-LOG with GPRS data transfer option with COMgate WAN, antenna, data transfer
software or with modem, antenna, data transfer software

» Connecting cables

» SIM card for modem (depending on provider)

Functional principle

A logger in measuring mode continuously stores data as defined in the configuration. If the test series is
completed (status of remote signal is inactive, e.g. terminal 15), data is packed and transferred via GPRS in
GSM network to the next node point. This data is then transferred via internet to a FTP server for being
available for download. All data transfer settings are defined in the IPETRONIK software.
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8.4.2 Transferring data using Wireless LAN to netzwork server

WiFi + Local Network —
—
. v
\\\ — User 1
( N —
v
v —

\\\ [ | U 5
WiFi ser
Client

|

|

|
- User 3
WiFi Network Server/ PC with
access point server network access

Components

» M-LOG, S-LOG, FLEETIog WAN, IPElog

» M-LOG, S-LOG with WiFi data transfer option with COMgate, antenna, data transfer software or with
client, antenna, WiFi software

» Connecting cables
»  WiFi access point to connect with network (M-LOG, S-LOG)

Funktional principle

A logger in measuring mode continuously stores data as defined in the configuration. If the test series is
completed (status of remote signal is inactive, e.g. terminal 15), data is packed. If the vehicle is within reach
of an access point (up to 300 m outdoors), data is transferred via WiFi to the access point. This data is then
transferred via local network to a server. If the local network is connected to the internet, data can also be
transferred to a FTP server for being available for download. All data transfer settings are defined in the
IPETRONIK software. Due to multiple encoding options (transmission protocol and user), a very high degree
of security against unauthorized access is guaranteed.
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9 Display modules
9.1 M-VIEWfleet

M-VIEWfleet is a alphanumerical data display, which is connected to the USB of the logger. M-VIEWfleet
provides different displaying modes besides four status LEDs and buttons. The number of displayed

channels is only limited by the processor load.

620-578.030 angled

620-574.015
Power + Remote
620-500.003, M-CAN

{ M-VIEW rreet ]
Termination (600-830.005, SIM-CAN)
620-500.002, M-CAN
(600-830.003, SIM-CAN)

Termination

I

M-Module

M-LOG PR0S
S-LOG

cANt
CAN4 DI/O

M-LOG-OPT-030
dovetail adapter

M-LOG-OPT-031
mounting plate

620-324.xxx open

600-580.xxx
D Sub D open

M-Module

Only connect M-
VIEWfleet to logger if
logger is switched-off. If
M-VIEWfleet is connected
to logger during operation,
the USB interface can be
damaged.

M-VIEWfleet is connected to M-LOG with an USB 2.0 interface. A second USB port of the logger is available
at the display. USB 2 is used for e.g. a program update or to exchange measurement or configuration data
via USB flash drive. USB connections are designed for a maximum length of 5 m. Display settings are

defined in the system configuration.
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9.1.1 Keys and LEDs

Operating status LEDs Value status LEDs
Red Error For induvidual control by
Green M-VIEW detected by logger

Value display
2-lines display of

user .
sianal and value
DATA/PWR socket
Cable connection to
logger

—

Light sensor
For brightness control

Audio input

To connect a
USB socket / microphone
For data exchange with
USB flash drive /

Status line

With additional
On/Off / information

Switch-on/off logger at

M-VIEW
Menu OK Up/Down
Start/Stop acquisition Switch, Scroll, Buzzer Manually scroll display
off, Clear alarm
Status line

The scroll mode MANUAL (with Up/Down keys) or AUTO (automatically) is displayed in the right zone of the
staus line. The following informatiojn is alternately shown in the left zone:

DATAFILE Name of current data file
TIME LEFT Available time in days (D) and hours (H) for data recording

DRIVER Selected driver

SHIFT Selected shift (track or road sections belonging together)
OK

Function in standard display

1. Display Min/Max Press longer than one second

2. Back to standard display Press longer than one second

Function in standard display in scroll mode AUTO:

(Changed from AUTO to MANUAL with Up/Down keys)

1. Back to auto scroll mode Press longer than one second

If the key is not pressed, the display changes after 30 s into auto scroll mode.

Switching from MANUAL to AUTO is only possible if auto scroll mode has been activated!
Function at configured alarm limit values:

1. Buzzer off Shortly press to switch-off buzzer

2. Clear alarm Press longer than one second, Back to standard view

If the alarm has already been cleared 5 times, a final message appears to definitely delete the alarm.

Up/Down A V¥

One line up A

One line down v

Switch AUTO > MANUAL A or V if AUTO (Auto scrolling) has been activated in configuration
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Menu
Stop acquisition -> Press longer than two seconds

Start acquisition -> Press longer than two seconds

The option Allow start and stop of acquisition must be activated in the configuration. The
measurement file number is increased by one at every acquisition start. If the option Track or
Track/Driver (List type selection) is additionally selected, files can be merged to one file until
the final end of data recording.

Devices connected to the logger remain switched-off until acquisition stop.

ON/OFF button (PIC firmware 2 V1.05 required on the logger!)

Logger on -> Press longer than one second

Logger off -> Press longer than one second

Green LED shows the status of the switch-on command. (LED on = REM2 ON)

Terminal 15 should not be used with the On/Off key because only one operation is supported
either with the On/Off key or with terminal 15. Mixed operations with both remote functions are
not possible.

Operating status LEDs
Red 1. Error

2. Logger is booting, initializing M-VIEW
Green Operation, M-VIEW detected by logger
Value status LEDs

The 4 status LEDs can be controlled with calculations. Additional limit violations can therefore individually be
displayed.

9.1.2 Configuring M-VIEWfleet

» Select Display in the tree structure.
» Select Add components.

» Select M-VIEWfleet. 40 Display 4| Seneral
4 __’ M-WIEWFleet M-YIEWFleet 4

Channels

» Select the desired signals.

. . . . G=  LEDs 5 Add compaonents e v Channel
» Confirm the desired signals with OK. -
4 O pisplay 4| General | Settings
B __’ M-YIEWFleet M-YIEWFleat 4 el
a
Q:: oo 7 (® Transfer fram channel configuration ;
= () Manual
4 m Data processing 12

Define the alarm values for the upper and lower signal limit, if desired. If the current signal reaches the alarm
limit, the display changes into the message window and the buzzer sounds. Clear the alarm with OK.

Activate the detection of the minimum and/or maximum values for the respective signal. With pressing OK,

the display changes into showing the minima and maxima. If the detection has not been activated, ------ - is
shown. Pressing OK again changes back to standard display.
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Define status LEDs for limit display

The 4 status LEDs can be activated by separate and user-defined calculation formulas. Additional thresholds
can therefore be defined and reaching these limits can optically be signalized. In addition, the LEDs can be
used as status display for the 4 digital logger outputs.

To do so, the following options are available:
» Use the same formula like at the corresponding digital output

» Status query of digital output to 1 (LED ON, for the time digital output = 1)

Swskems

Marme Type Z |l=
a4 _f S0099999 M-LOE (2 2., 24
CAM D01
CaN 02
DIN
DT
LUSE
ETH
COM-1
COM-2
Audio
Display
] MVIEWFleet M-YIEWFlest

Marne Active Uik Phys Min Phiys Max SEnso

LED 02
LED 03
LED 04

O 0O CIL N m

"Qlol ||0I-r E

1 4

General | Format | Scaling | Display | Caloulabion | Limit walue | Movalue

O BDD

Formula; | "DIM 01"=1

B I = =~ T~ T — T N R |

Channels

1.
(=
4 @ Daka processing

—_
)

Setting display modes

Select Active to use M-VIEWfleet in the configuration.

No further settings can be defined without activating M-VIEWfleet! If an existing M-VIEWfleet
configuration is deactivated, the logger display has no function! This is signalized by the red
LED. The red LED is also on if the USB port is damaged during operation by disconnecting the

cable.
4 O Display 4| t=eneral | Mode
M-YIEW Fleet M-WIEMW Fleet 4 el stz GG .
L Channels 4
o= LEDs 4 List type: | OFF -
4 @ Data processing 12 Allow start and stop of acquisiton: [
4 Status 12 )
= Merge measurement Files:
@ Local storage groups
@ Local calculations n Confirm shiftftrack at stop
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Scroll mode

Off Manually switching lines with Up/Down

5s Continuous line switching in interval of 5 s, display moves line by line from the bottom up
in order of signal list

List type

Off Neither track nor driver defined

Track Track selection by driver is assigned in data

Track/driver Track, as well as, driver are selected before start and set in data

The text file of the track selection list is defined in:

..\IPETRONIKW\WPEmotion MAL-Plugin IPETRONIK LOG V03.xx.xx\Data\MViewfleet\MVIEWfleetTracks.txt

The text file of the driver selection list is defined in:

..\IPETRONIK\PEmotion MAL-Plugin IPETRONIK LOG V03.xx.xx\Data\MViewfleet\MVIEWfleetDrivers.txt
Changes of the entries can manually be defined in the respective text file.

Allow start and stop of acquisition

Pressing the menu key stops the data storage and the current measurement file is closed.

Pressing the menu key again starts the next data storage and the number of measurement file is increased
by one.

Merge measurement files
This function requires a selected list type!

The end of every acquisition includes the End Shift xxx query. If it is confirmed with OK, all previous partial
acquisitions of one file are merged and the number for the next measurement file is increased by one. If this
function is not activated, an own file is written after every acquisition stop and a following acquisition is
recorded with a new number.

Confirm shift/track at stop
A selected list type is required for this function and Merge measurement files must be activated!
The query runs after acquisition stop:

End Shift xxx! Yes OK? Track is stopped, partial acquisitions are merged in one
measurement file

No OK? Track is continued at next start with same measurement file
The query runs after acquisition start:
Shift xxx Good Trip! OK? Currently saved track is continued with new acquisition file

Change OK? Track and driver can be selected again

If nothing is entered after a query, an acoustic message sounds after 20 s and the saved
settings are accepted for the next acquisition.
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9.2 M-VIEWgraph

Important advice for mounting!

If mounting with a suction pad holder, the bottom of the display enclosure must be additionally
fastened with Velcro tape to an underlayer/board (e.g. dashboard). Free mounting only with the
suction pad holder is not permitted for test drives..

M-VIEWgraph is an alphanumerical and graphical data display.

The display is connected to the logger via USB port. In addition to two status LEDs, it provides four trigger
LEDs to show limit violations. The display is controlled with 12 illuminated keys, 4 keys with standard
functions, 8 keys, which can individually be defined (projected).

The illuminated 7” TFT display has a resolution of 800 x 480 pixel to display graph charts and numerical

values.
Power9 ... 36 V
620-595.030
M-VIEWgraph
620-574.015
Power + Remote
620-500.003, M-CAN
Termination , (600-830.005, SIM-CAN)
620-500.002, M-CAN
(600-830.003, SIM-CAN)
Termination
M-LOG PR05 :“‘ """ J“.
$-LOG ! ;
M-Module ! P I M-Module
(SIM-Module) ! 1| (SIM-Module)
CANt ! i
CAN4 DO oL !

600-580.xxx
D Sub open

Logger_Manual_V03.51

620-324.xxx open

M-LOG-OPT-030
dovetail adapter
(M-Modules connection)
M-LOG-OPT-031
mounting plate

IPETRONIK GmbH & Co. KG

M-VIEWgraph cannot be
supplied with power via
the logger as M-
VIEWfleet.

A\

Connect M-VIEWgraph
and logger ONLY if
switched-off, otherwise the
USB interface could be
damaged.

A

ALWAYS connect PWR-
(black banana male
connector = PWR-GND) of
the M-VIEVgraph cable to
avoid overload of the
signal GND line (GPS
power, Remote2).
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9.2.1 Keys and LEDs

Operating status LEDs Value status LEDs On/Off Light sensor
Red Error For induvidual control Switch-on/off logger For brightness
Green M-VIEW by user at M-VIEW control
F1 left \ / / / F1right
Scroll up in limit value
\ / window
F2 left F2 right
\ / Buzzer off
F3 left F3 right
\ Clear alarm, Exit limit
value window
F4 left —
F4 right
Scroll down in limit
// \ \ value window
Page selection Page up OK Page down
Switch-on/off logger Scroll one page Buzzer off Scroll one page
at M-VIEW uo down

The functionality of keys F1 right to F4 right is also available with the touchscreen of the alarm window.

The side keys F1 to F4 left and F1 to F4 right can be used to control data recording with a corresponding
configuration, e.g. as start- and stop-trigger.

9.2.2 Configuring M-VIEWgraph

M-VIEWgraph supports the display of any number of pages. Due to the fact that the processor capability is
limited, it is recommended not do create more than 20 to 30 different pages (depending on the proportion of
graphical elements).

Configuration of up to 15 pages/200 signals have been tested. Bigger configurations could
cause displaying problems.

Use devices with a serial end number > 116 (Processor PXA320) only with firmware version >=
1.05.

Add M-VIEWgraph, display pages, and channel
» Select Display in the tree structure.

» Select Add components.

» Select M-VIEWgraph.

» Add a Display page + Channel.
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Define status LEDs for limit display

The 4 status LEDs can be activated by separate and user-defined calculation formulas. Additional thresholds
can therefore be defined and reaching these limits can optically be signalized (see M-VIEWfleet).

Define display page

The display can be separated into different areas. A page title can be assigned to every page (invisible in
measuring mode) and a title can be assigned to every screen zone (visible in measuring mode).

The following layouts can be selected with the current IPEmotion version:

» Full screen

» Horizontal tripartition

» Horizontal bipartition (The screen is horizontally divided to 50% each. The upper area shows
graphs and the lower one the current value as numerical display.)

» Horizontal bipartition 75 % to 25 %

» Vertical tripartition

» Vertical bipartition

» Vertical bipartition 75 % to 25 %

» Dynamic

Example 1: Display layout Vertical bipartition

The screen is horizontally divided to 50% each.
Both areas show an alphanumerical display.

The scientific display of values (e.g. 1e-03) is used from TESTdrive 3.17.01 only for very great

values.

Graph display settings

A Ch_ Display

4] MvIEWfleet M-VIEWY. .

5= LEDs
rl |:| Display page 01

Cl Display area
B Display area
A @ [rata processing
¥ Stakus

Type

Graphs

Numerical display
Updating mode

50 %-Scroll

Autoscrolling

Autoscaling

Logger_Manual_V03.51

General | Display

4
4
Type: Graphs -
4
0 Updating mode: | Autoscrolling - Wisible columns: |1
1 ®-axis areat |30s - Text color:  |Elack ~

[=]

= One joint y-axis:

17 Line width: |1 -

Displaying type

Signal displaying in curves/graphs
Numerical signal displaying
Scaling type of x-axis

If the defined interval in x-axis area is elapsed, 50 % of the window are
moved to the left and the graphs move from the middle to the right. If they
reach the right end, the 50 % window is moved into the left area and so
on.

If the defined interval in x-axis area is elapsed, the current graph data
continuously move from right to left.

If the defined interval in x-axis area is elapsed, the graph data are accu-
mulated, i.e. scaling of the time axis is dynamically fit.
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X-axis area Displayed time interval at x-axis

Select an interval from 15/ 30s, 1/ 2/ 5/ 10/ 20/ 30 min, 1/ 2 h.
One joint y-axis One joint y-axis for all graphs
Line width Line width of graphs

Define the line width of all graphs in this area, selectr from 1/2/3 pt.

Numeric display settings

Visible columns

Division of the current screen area for numerical display in horizontal and vertical columns.
Text color

Define the text color for all numerical displays in this screen area.

If a Channel is selected, following settings can be defined in Numerical display tab:
Name

Enter an alternative signal name, e.g. as short description if the original name is too long to show at the
configured M-VIEWgraph display.

Integer places
Number of digits to the left of a separator
Decimal places

Number of digits after a separator

Define limit values (Alarm function)

Limit values of displayed signals can be defined with the main menu
Acquisition > Add limit value.

The respective signal limits are directly defined in the signal dialog
(channel configuration)!

After every limit violation, the display changes into limit value window and
the buzzer sounds. For the time the limit violation is applied, the signal is
dislpayed in red.

Following information is shown in the limit value window:

» Signal (signal name) with current value and unit

» Date and time of violation

» Number of previous violations

» defined lower limit value

» defined upper limit value

» Minimum signal value

» Maximum signal value

» Status information (file name, available memory duration, date, time)

Scroll through the single limit value windows with the arrow keys of the touch screen or the F1 / F4 keys if
several alarms apply.

After clearing the alarms, the display changes into the measuring window. If the limit violation still applies,
the respective signal is shown in red. A change into the alarm window only takes place if a new limit violation
applies.
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Acquisition start and stop

see M-VIEWfleet -> Configuring displaying mo

Shift/driver function

see M-VIEWfleet -> Configuring displaying modes

ON/OFF

The logger can manually be started with the ON/OFF button at M-
VIEWgraph. Press the key for approx. 2 s to start the logger and the
acquisition. The display LED is on and signalizes operation. An
acoustic signal sounds during measuring mode. Press this key again
to stop acquisition and shut down the logger.

Please note that the terminals 30 and 31 of the logger are connected (not terminal 15)!

Simulate function Keys Menu, Up, Down, OK

TESTdrive 3.22 offers the additional keys (Menu, Up, Down, OK), which can be controlled with a trigger.
Activating a respective key can be simulated with a corresponding formula.

4 Eﬁ_ Anzeige
41 mMvIEWwgraph M-wIE\Wgraph
5= LEDs
A ’:l Display page 01
B Display area
& Cisplay area
4 Keys

General | Trigger

Formula: |"DIN 01" =1

Fie)

= - —- - O &~ &~ &

A
Menu
Up

Dowin

[ R e R ]

The example shows the “OK*" action, e.g. “Switch-off buzzer”, as soon as the digital input is high.

Logger_Manual_V03.51 IPETRONIK GmbH & Co. KG ipetronik.com 99/ 123



Display modules

Event handling

Event signals can be used to control data recording, as well as, to switch-on/off external components via the

digital outputs.

Systems

Mame

4 B M-LOG (2 CAk)
AN 01
CAMN 02
DI
DouT
LISE
ETH
COM-1
ComM-2
Audio
Display

L unge v
it =

@

HO0:DD

[Data processing
Skatus

Local storage groups

al
2
@ Local caleulations
“ 3

Ewent handling

>

M-WIEWgraph F1 left
M-%IE\Wgraph FZ left
M-%IE\Wgraph F3 left
M-%IE\Wgraph F4 left
M-YIE'wgraph F1 right
M-WIE'wgraph F2 right
IM-WIE'wgraph F3 right
M-WIE'graph F4 right
BeepOn

BeepOff

ManitarCn

TonitonZEF

Lirnit *iolation On

Lirnit *iolation OFf

P
DDDDDDDDDDDDDDI

Triggeredshutdown

M-VIEWgraph Fx xxx
BeepOn

BeepOff

MonitorOn
MonitorOff

Limit violation On
Limit violation Off

TriggeredShutdown

Logger_Manual_V03.51

Marme Active  Unit Fhiys Min Phs Ma Ser

Type . Z = m

M-LOG (2 ... Add event signal

signal 01

1. Select Event signals from the
Signals tab.

2. Select Add components from the
tab menu or with the context menu
(right mouse button).

3. Select Event signal to add it to

4 4

General | Format | Scaling | Display | Extended | Limit value

Triggering event: Select

Resetting event: Select

rIVIEWWgraphkeyLeftF1

MYIEW graphkeyLeftF2

MYIEW graphkeyLeftF3

MYIEW graphkeyLeftF4 Select events

MYIEW graphkeyRightF1

MYIEWgraphkeyRightFz 1. Select the Event signal from the list.
MVIEW graphkeyRightF3 2. Activate Extended tab.

MVIEW graphkeyRightF4 3. Select Triggering event.

BEeEER 4. Select Resetting event.

BeepOff . .
Moritoron The ;tatus of_ the respe_ctlve _event §|gnal
- remains applied from triggering until
Limit¥iolationon

LimitiolationoFF

ShutDown

side keys (right/left) F1 to F4 at M-VIEWgraph
Buzzer is activated

Buzzer is deactivated

M-VIEWgraph is switched-on

M-VIEWGgraph is switched-off

At least one limit violation applies.

No limit violation applies.

Remote signal logger off, Logger still in follow-up time
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10 Accessories

10.1 Electrical accessories
10.1.1 COMgate

COMgate is an intelligent extension device for logger and allows remote transmission of measurement and

configuration data.

M-COMgate in mounting enclosure for M-LOG
COMgate is available in 2 versions:

COMgate WLAN acc. to WiFi 80

COMgate WAN WLAN acc. to WiFi 80

2.11 a/blg

2.11 a/blg

and modem for GSM/GPRS/3G

FME for modem antenna

LED status display

LED display Status
DNGREEN I #vron
MODEM
MODEM
ORANGE MODEM

WiFi

WiFi

YELLOW WiFi

4 status LEDs \
SMA for WiFi antenna /

/

Lemo OB — socket PWR / ETH
Cable 620-614 to logger with
ETH socket Lemo OB 7-pin

Meaning
Device is ready for operation

(operation: see LED yellow or orange)
Establishing connection to UMTS/GPRS network
Successfully registered to UMTS/GPRS network
Steady connection

Establishing connection to WiFi network
Successfully registered to WiFi network

Steady connection.

Interference, potential reasons are:
- transfer of new configuration

- wrong configuration loaded

- general operating interference

M-COMgate requires additional external cooling on M-LOG at operating in ambient

temperatures > 70 °C (158 °F)!

Logger_Manual_V03.51
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10.1.2 Extender
CAN-Extender

/ ot

Input with status Operating status ETH/PWR socket
LED (Bus traffic) LEDs to M-LOG

M-LOG Extender is an extension device with 4 additional CAN inputs. M-LOG devices, which are already
equipped with a LX800 processor board, as well as, the option Input 2x Ethernet, can be extended without
modifying hardware. The extender is screwed to the bottom of the basis device with 4 screws and connected
to the logger with the cable 620-406.002 (here PR08, or 620-404.002 for PR03 and 620-405.002 for PR04).

Requirements
» Data logger with LX800
» Option Input 2x Ethernet (with respective port replicator)

» free Ethernet input
» IPEmotion + LOG-Plugln = 03.19 (Creation and configuration see ETH 01/02 port)

Advices

» The bus inputs of the extender do not support WakeOnCAN and traffic acquisition.

» Data is directly stored on the logger.

» The maximum data rate is 100 Hz.

» The configuration is extended by the additional file *.ecf (Extender Configuration File).
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10.1.3 GPS receiver
» GPS mouse for satellite positioning
» Connection to the serial logger interface

» Predefined settings of NMEA protocol configuration software

10.1.4 Bus isolator SAM-CAN-ISO

» High ohm connection of hardware to vehicle
CAN

» Electrical isolation between vehicle bus and
measurement system

» Connection with short stub

» Version “Hear only* to avoid unintended in-

fluencing of vehicle CAN SAM-ISO011-23A0

Has el approval (Vehicle Type Approval VCA) for
directly connecting with the CAN bus of public
vehicles without restricting the type approval.

10.1.5 iMIC
» compact multifunction device (1.57 * 1.44 * 0.98 in) (40 * 36,5 * 25 mm)
» Voice recording with audio input o — ah

» good voice quality
» illuminated trigger button e
» 3 status LEDs (green, yellow, multicolor)

» integrated buzzer

Button (illuminated)

Triggering of data recording and/or voice recording via digital input 1.

Status LEDs
LED Yellow Indicates the status of digital output 2 (LED is on if output is active.)
LED Red Indicates the status of digital output 3 (LED is on if output is active.)
LED Multicolor

green Indicates the status of digital output 1 (green light)

blue Indicates the satus of the yellow LED (blue light)

red Indicates the completed boot process. The excitation of the connected devices (at M-
CAN or SIM-CAN socket) is switched-on.

Buzzer

Acoustically indicates the status of digital output 3 (Buzzer ON if output is active).

The specific functions of the digital inputs and outputs are defined in the measurement
configuration (see Standard functions calculations, trigger, Use of digital inputs and outputs).
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The button functionality, as well as, the LEDs and buzzer functionality also depends on the
wiring / PIN assignment. If another cable than 620-607.xxx is used, functionality can differ from
the one described above.

Cable 620-607.xxXx
P1

=

[s]

B ﬁi:iﬁ

15

o T

|\‘ ‘
Frontseite E/\E::Ij%
[ ‘

P5
A
| = <o g@g@;\

P4 H Frontseite
LOG - iMIC
© 9 620-607.XXX
N
Frontseite XXX = Lénge [dm]
PIN assignment cable 620-607.xxx
P1
'
1 DIN-1
2 DIN-2
3 DIN-3
4 DIN-4
5 DIN-GND - : . i
6 ) LOG-PWR +PWR/Multi-LED=Rot —3
DI/IO | 7 A LED1 (griin) Multi-LED=Griin 0
B - LED2 (gelb) __LED=Gelb ( —g
s 3 LED3 (rot) | LED=ROT+SUMMER] —5
DIN-GND ~  Multi-LED=BLAU - — |
10 H 4 |iMIC
11 DOUT-1 —>
12 3 DOUT-2 —
: DOUT-3 ~ TASTER -
13 — 1
14 A DOUT-4 MIKROPHON =g
; DOUT-COM
L1 il [
1=t MICR-REF A
Mikro/ 2] MICR-SIG
Headphon | 3 —/ HEADPHON-GND
4 MICR-GND
5 HEADPHON
1 I

Logger_Manual_V03.51 IPETRONIK GmbH & Co. KG ipetronik.com 104/ 123



Accessories

10.2 Mechanical accessories
10.2.1 Module mounting
Dovetail adapter

Adapter plate for mounting to the right
M-LOG housing for connecting M
devices without tools.

Fastening elements

2 fastening strips for mounting
at the device bottom to screw M-
LOG to an even surface.

Snap-in fastener

2 snap-in holders + 2 fastening strips
for mounting at the device bottom to fix
M-LOG at an even plate without tools.

Snap-in adapter

Mounting plate to use a snap-in fastener to fix M-LOG to plate without tools.

Suction pad holder for M-VIEWfleet / M-VIEWgraph

Suction pad holder with pump for fixing driver display on smooth Figures are
surfaces e.g. at windshield. subject to
change!

Due to safety reasons, the bottom of the display housing must rest on an underlay (e.g.
instrument panel). Avoid a free mounting and do not use the suction pad holder alone for drive
tests.
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11 Appendix

11.1 Cable connection and Pin assignment

11.1.1 M-LOG port replicators

Port replicator PRO5 (4x Sub D 9, PWR-IN/REM Lemo 1B 6 pin)

Internal circuits PRO5

Portreplikator | M-LOG Grund

7 0@
+Umioc Q% 69
f———fp  M-POWER

2.5A MultiFuse
Modem Power

2.5A MultiFuse

——d % GPS Power

0.3A MultiFuse
Power

0.3A MultiFuse

CAN1

0.3A MultiFuse
L pcanz

0.3A MultiFuse

[ —pcans

0.3A MultiFuse
L —pcans

UBOUT(4x)

0.1A MultiFuse

0.1A MultiFuse

_E'_> LED Griin

0.1A MultiFuse

——o{ —J LED Geb

0.1A MultiFuse

_E'_> LED Rot

Cable reference PR0O5

Ethernet/ 620-591xxx RJ45

| . 8.4V/45A
> CAP

favza o oo

5V/0.5A > 5v0

5V/0.003A
— > PIC

620-550.0« Phonejack 3 wire 3,5mm

WLAN

DIG INJOUT  620-324x0¢ open

620-551 .00« Phonejack 3 wire 2,5mm Micro /
Headphone
620-577500¢ Sub-D, RJ11, Tuchel
RENMIVIE
620-578.50x Lema angled
M-VIEW

LED 1-3
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PIN assignment PRO5
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Port replicator PR0O8 (4x Sub D 9, ETH, PWR-IN/REM Lemo 1B 6 pin)

PIN assignment PRO8
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11.1.2 FLEETIlog
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11.1.3 IPElog
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11.2 Starting up
11.2.1 Overview Configuration & Measurement

Configuration

Start
Configuration

Create new
Device/System

CANdb

or ASADS £
o ASAPZ foi

CAN config?,

SIM- or
M-Modules and
M-LOG?

Yes

Configure modules
directly or import
CANdb

No

A

USB > M-LOG
Measurement data M-LOG > USB

Configuration file

Ll‘
V|‘

[e———Measurement

Save Configuration
to USB stick

v

Insert USB stick
to M-LOG

easurement
data on
M-LOG?

M-LOG saves data
on USB stick

No

A

Copy new config.
to M-LOG

v

Remove USB stick
(as soon as yellow LED
is permanently off)

&
hl

Y

USB stick
insert?

Gather and store
measurement data
as configured

Stop Measurement
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Configuration via IPEmotion
(license required)

Create new or read and process
existing configuration.

Configure bus measurement input by
import of the respective description file

Configure via IPEmotion

Save configuration as an MCF file (*.mcf).

In case M-LOG is switched off,
> switch on the module before.
(Do not switch on M-LOG with
the USB stick insert!)

If not already existing, M-LOG creates an
specific subdirectory and saves measurement
data and the latest configuration to the USB stick.
The name of the subdirectory consists of the
serial number of M-LOG.

Transfer new configuration from the USB stick
to M-LOG

M-LOG automatically starts the measurement
application and reads the current configuration.

M-LOG will switch off as soon as the remote
input becomes inactive.
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11.2.2 Flow chart of the measuring process

Operation Status

Mo

cll g
lgnition
line157

WAKEonCAN
hus traffic?

v

Ring buffar
measurament

CAFs
charged?

LEDs
normal

LEDs
emerge ncy

3

+=

Compact flash
measurement

Emergency?

Ignition line 16%.

Fower off Mo

delay expired?

Stop measurement|
Close file
Zip flles

Stop measumment]
Cloze file

Medem On
Send data

Shut down
PC
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Comment

FPulse duration ignition line 15> 20 ms.
When switching on via remote pulse, the
continuous remote signal is required
within 60 5. Otherwise the logger will be
switched off by the power management!

With the WAKEonCAM function the
remete signal (line 15) is required within
the configured timecut delay
(10s...72005s).

Otherwise the logger will be switched off
by the power manage ment!

In case of emergency before the
CAPs are fully charged, data storage
to ¢F card is impossible.
Measurement data will get lost.

V gwaion < IV TOr t > 2 min
or

\Y <GV fort>0.2s

Pulse duration ignition line 15> 1 s

If no power off delay is configured, the
falling edge of the ignition line 15 will
shut down the logger immediately.

If the ignition line 15 signal is applied

fort =1 s during the data transfer,
transfer will be stopped and measurement
will be restarted!

If the operation voltage arises to

Voo = 9V after emergency, the logger
will be switched on again through the
applied igniton line 15 signal.
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11.3 Practical examples
11.3.1 Calculating memory footprint

The memory footprint per storage group results from the following data
» Memory footprint of acquisition channels +
» Memory footprint of time channel (relative and absolute time channel) +

» Memory footprint of header (description file)

Memory footprint of acquisition channels

Acqu. duration [s] x storage rate [1/s] x channel count x 2 Byte = memory footprint in Byte
Memory footprint in Byte / 1024 = memory footprint in kByte

Memory footprint of time channel (IPE:Clock = relative time channel)

Acqu. duration [s] x storage rate [1/s] x 4 Byte = memory footprint in Byte

Memory footprint in Byte / 1024 = memory footprint in kByte

Do not mix the time channel (relative) with the time stamp channel (absolute = Date, time). The time stamp

channel is only recorded if activated in storage group dialog.

Memory footprint of header file

The memory footprint of the header file depends on the size of acquisition configuration (channel count,
sampling rate, different data formats, ...) and cannot be defined by a general formula. The size of the header
file is usually much smaller so that it can be neglected. Exceptations are short acquisitions or acquisitions

with many channels at low storage rate (< 1 Hz).
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11.3.2 Linear signal scaling

The conversion of a raw value (binary value, e.g. in a CAN message) into a physical value (value with unit) is
effected with the scaling. IPETRONIK offers the scaling calculator and supports linear scaling with the line
equation as factor/offset or 2 point scaling.

The scaling of a voltage or current signal (sensor output) into a corresponding physical or percentage value
is effected in the same way. The following examples show the connections.
Mathematical basics for the linear equation

A
y

y1 =

b
— [ R N B N —>
1 X
Point gradient form Two points form
y=m*x+b m = dy / dx

b=y-m*x
m = (y1l -y2)/ (x1 —x2)
m = Gradient (gain)
b = constant (offset) m = Gradient (gain)

Calculation and explanation
1. The linear equationy = m * x + b shows the mathematical connection.

2. Calculate the m gradient within any input range (signal) and the related output range (physical
value).

Calculate the offset b by using the x and y values for a known point.

Calculate, if required, further y values by using the corresponding x values and the equation, e.g. for
calculating the physical values for another input range (Channel min, max).
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Example pressure sensor

A pressure sensor has an output signal of -0.5 to 4.5 V in the acquisition range O ... 20 bar.
The voltage signal is converted to the physical value with the linear scaling.

Pressure { bar

[ 28 | I | | |

I I | | I I
— i | I —1—

I | I | /'I/ I

| | | | |

} 5] } } } et }

| | I I | |

I | I | |

|0 | | | I

| 7 | | |

| B | | | |

’L/g | | | | I

] | | | ]

\y “ 1 1 1 1 1

- | of | 1 | 2 | 3 | 4 | 5
I I I I I I
K3
Excitation !V

x1 X2 yl y2 b’ b
4.5 -0.5 20 0 4 2 2

Example CAN raw value in the Word unsigned format als temperature

A temperature signal is a CAN message in the Word unsigned format. The value range of 0... 65535 (16 Bit)
corresponds to a temperature range of -50 °C ... +200 °C.

Temperature | ¢

200

150

100

50

Please note that the output range has an offset of —50 °C. This must be respected at
calculating: (b’ = Offset without output offset, b = Offset + output offset).

......................................

8192

x1
65535

Logger_Manual_V03.51
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200

______________________________________

Raw data / Bit

y2
-50

___________________

m
0.0038147
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Example CAN raw value in the Word signed format as temperature

A temperature signal is a CAN message in the Word signed format. The value range of -32768... 0 ... 32767
(16 Bit) corresponds to a temperature range of =50 °C ... +200 °C.

Please note that the output range has an offset of -50 °C. This must be respected at
calculating: (b’ = Offset without output offset, b = Offset + output offset).

Temperature {°C

. ; /-16384 ‘ -3192 ‘ “0 §192 ‘ 18384 ‘ 24578 ; azms.
Raw data | Bit
x1 X2 yl y2 m b’ b
32767 -32768 200 -50 0.0038147 125.0019 75.0019
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11.4 Status messages
11.4.1 Most important status messages

Following message types are defined:

| Information W  Warning E Error D Debug

Type number: XXX-XXX-XXXX

Number corresponds to the number of the type plate of M-LOG (entry in hw_descr.xml).

Wait max. 3min for write permission (power good)

M-LOG waits until CAPs are loaded (status message "Power good" from PIC). If status is “Power good", data
is written to flash. If this status is nor reached, (PIC) switches off M-LOG after 3 min.

Power good

Message (from PIC) that CAPs are loaded.

Debounce remote signal 1000 ms
Remote signal must be on at least for 1 s to reach “ON“ status. (Debouncing of remote signal)
Remote signal is detected as such if excitation > 6.5 V at PIN terminal:15 of PWR-IN/REM socket.

Watchdog active

PIC transfers control of M-LOG to TESTdrive.

Function: Testdrive cyclically describes a storage range in Powermanagement (PIC) (toggling bit). If
this toggling fails for more than two minutes, M-LOG is switched off by Powermanagement
(PIC).

Free disk space: XxXx/xxx

Indicates the available total memory space. TestDrive 3.09 shows a "Free disk space: xxxx" at the left
bottom display window. It shows the available space for data storage (40% of total memory space). Initially,
this value fluctuates intensively but stabilizes with a longer acquisition because it is recalculated
permanently.

Time left: XX XX:XX:XX

Display bottom left in monitor window. Meaning: d hh:mm:ss

Power bad
If excitation is too low, status is “Power bad".

Info: This message is not concerned with CAPs contrary to "Power good" message.

Can'tinitialize communication mediums

Dev_conf.xml is not included in Config, i.e. no data transfer activated.

Shutdown in 55 min

If data postprocessing (zipping, establishing, data transferring, data sending, etc.) is not completed within 55
min, Testdrive shuts down and data remains on logger.

Emergency shutdown in 60 min

Logger is unconditionally shut down after 60 min. Powermanagement of M-LOG controls the device.
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Time left: XX XX:XX:XX

Display bottom left in monitor window. Meaning: d hh:mm:ss

Power bad
If excitation is too low, status is “Power bad".

Info: This message is not concerned with CAPs contrary to "Power good" message.

Can't initialize communication mediums

Dev_conf.xml is not included in Config, i.e. no data transfer activated.

Shutdown in 55 min

If data postprocessing (zipping, establishing, data transferring, data sending, etc.) is not completed within 55
min, Testdrive shuts down and data remains on logger.

Emergency shutdown in 60 min

Logger is unconditionally shut down after 60 min. Powermanagement of M-LOG controls the device.

11.4.2 Warning and error messages after program update
Program options without license

TESTdrive Version 3.17 includes a license software to check the use of logger / TESTdrive options. This
requires sending new license keys to the logger.

After a TESTdrive program update, potential warning messages can indicate locked options. TESTdrive
checks if used functions are really unlocked on the logger. Following warning is written into log file if e.g. all
inputs of a card with 4 CAN inputs is used but only 2 are unlocked.

01.04.2009 14:11:45 W CAN1 : Upper limit of licenced CAN interfaces reached. Max= 2

Please contact the sales team at +49 7221 / 9922 — 222 to assist you with warning and error messages, as
well as, licensing.

TESTdrive V03.22 deactivates the non-licensed functionality and warns with the red status LED
(temporarily at acquisition start). Depending on the missing license, acquisitions are limited
(e.g. possible calculations but no classification) or disabled (e.g. at missing license for
interface).

If an extender is used at the logger, an additional license for the extender is required!

The system shows the following warning if an extender is used with a non-licensed CCP protocol:
16.02.2011 15:36:01 E Extender.80200011: Error reading XML-Buffer at line 11
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11.5 Description of TESTdrive files

TESTdrive provides the measurement files as zip archives. TESTdrive creates separate zip files for every

acquisition:

MEA_xxxx.zip (Acquisition data + header file + current configuration)

LOG_xxxx.zip (Protocol file for data acquisition)

A data set of an acquisition always includes a header file (AABBCCC.DAT), at least one acquisition file in
DIAdem format, as well as, the corresponding acquisition configuration (e.g. IPEmotion.isf).

The names of the single acquisition files are generated according to

the AABBCCCC.DDD structure:

AA
BB
CCcCcC
DDD

After reaching the consecutive file

Data type number 9999 (CCCC), counting starts
again with 0001!

Consecutive number within a data type

. . If the file with this number still exists, it
Consecutive number of an acquisition Sovermtentyinewidaal

File extension

AA data type indicates the type of data:

DO

PM

co

AO

VO

J

ST
TBQS, T
MV

Data Online (storage group with time channel)

Post Mortem data of a ring buffer group (storage group with time channel)

(C) Classification Online (storage group with statistic data, without time reference)
Audio Online

Video Online

Job data = Diagnostic data

Min-Max list

CAN/LIN traffic acquisition (during or after boot process)

Maneuver recording

The consecutive BB number clearly assigns data within one data type. Several storage groups for instance
can be detected with real-time data, which are distinguished from each other by this number.

The consecutive CCCC number differentiates between single acquisitions. Each acquisition is therefore

clearly defined.

The DDD file extension defines the data format as follows:

DAT
T64
w8
w16
W32
116
132
R32
R64
WAV
AVI
CSsv

JIXX

Logger_Manual_V03.51

DIAdem header file

DIAdem time channel with 64 bit resolution

DIAdem data with 8 bit unsigned (BYTE)

DIAdem data with 16 bit unsigned (WORD)

DIAdem data with 32 bit unsigned (WORD)

DIAdem data with 16 bit signed (INTEGER)

DIAdem data with 32 bit signed (INTEGER)

DIAdem data with 32 bit in floating point displaying (REAL)
DIAdem data with 64 bit in floating point displaying (REAL)
Audio file in WAV format

Video file in AVI format

Comma Separated Values

Binary file with job result
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Recorded signals are divided into different files accordingly to data typet, i.e. all 8 bit signals unsigned are in
a *.\W8 file, all 32 bit signals signed in a *.I132 Datei, etc.

Important advices:

TESTdrive defines the number of the storage group during the initialization process. An assignment of the
storage group number to the order in the configuration interface is not given.

All information of a storage group is stored in the DAT file. The DAT file has a 8 bit ASCII format (ANSI code
page 1252, ISO 8859-1).

The storage group name can be defined with IPEmotion and is also stored in the DAT file.

All project information are stored in the DAT file (vehicle no., project name, etc.). At working with
classifications, the DAT file contains additional fields to define the classification in detail.

11.5.1 Datatypes

Time-related data (Storage group)

The header file and the corresponding data files are created for every storage group (= signals with common
storage rate).

Example (Acquisition no. 699 > DOBBCCCC.DDD)

Storage group 1 DO010699.DAT Header
D0O010699.R32 32 Bit (Real)
D0O010699.W16 16 Bit (Word unsigned)
D0O010699.W32 32 Bit (Word unsigned)
Storage group 2 DO020699.DAT Header
D0O020699.W8 8 Bit (Byte unsigned)
D0O020699.W32 32 Bit (Word unsigned)
Storage group x DO0x0699.DATHeader
DO0x0699.W8 16 Bit (Word unsigned)
Statistics

TESTdrive saves classification data in DIAdem format, which includes all parameters in one header file. This
header file includes additional information about classification description. Corresponding to the storage
groups and the general DIAdem conventions, binary data is included in the same files. These files are
separated accordingly to data type and are defined by an extension corresponding to data type, e.g. *\ W32,
* R64.

The results of several classifications of the same data type are stored in one binary file. Most classification
types create results of the W32 data type. The retention time classification can create different data types.

Example (Acquisition no. 699 > COBBCCCC.DDD)

Header CO010699.DAT Header
Classification m ... n C0O010699.W32 32 Bit (Word unsigned), can include several
classifications
C0O010699.R64 64 Bit (Real), can include several classifications
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Audio recording
A DIAdem acquisition and one or several audio files (WAV format) are created with an audio recording.
The DIAdem acquisition contains the trigger event, the WAV file includes the audio data.

Every audio file is assigned to one triggering event. The names of the audio files include the counter value of
the trigger channel to create a direct reference within the acquisition data. The respective audio file is
recorded for the time of an activated trigger.

Example DIAdem file (Acquisition no. 699 > AOOOCCCC.DDD)

Trigger channel AO0000699.DAT Header

A0000699.W16 16 Bit (Word unsigned)

Example audio file (Acquisition no. 699 > ABBBCCCC.WAYV)

Audio sequence 1 A0010699.WAV Audio data of 1. trigger event
Audio sequence 2 A0020699.WAV Audio data of 2. trigger event
Audio sequence x A00x0699.WAV Audio data of 3. trigger event

Video recording

A DIAdem acquisition and one or several video files (JPG = single image or AVI = video sequence) are
created with an video recording.

The DIAdem acquisition contains the trigger event, the JPG or AVI file includes the video data.

Every video file is assigned to one triggering event. The names of the video files include the counter value of
the trigger channel to create a direct reference within the acquisition data. The respective video file is
recorded for the time of an activated trigger. Exactly one single image is saved per trigger event,
independent of the trigger duration.

Example DIAdem file (Acquisition no. 699 > VOO0OCCCC.DDD)

Trigger channel 1 (Video) V0000699.DAT Header
V0000699.W16 16 Bit (Word unsigned)
or
Trigger channel 1 (Image) I0000699.DAT Header
10000699.W16 16 Bit (Word unsigned)

Example video file (Acquisition no. 699 > VBBBCCCC.AVI)

Video sequence 1 V0010699.AVI Video data
Video sequence 2 V0020699.AVI Video data
or

Image 1 10010699.JPG Image data
Image 2 10020699.JPG Image data
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Diagnostic acquisition
Error memory and non-recurring data

TESTdrive creates additional files for error memory and non-recurring data. This CSV file (BDJDcccc.CSV)
is an overview and includes all information about the completed jobs. Every successful job is saved in a
binary file (BDS1cccc.Jxx), which contains the actual data.

A CSV file**, as well as, the corresponding jobs are created after the completed acquisition of UDS services.
** A CSV file is only created in binary mode, not in trace modeT.

The names of the single acquisition files are generated according to BDPECCCC.DZZ structure:

BDPECCCC.Dzz with P = U (UDS protocol), P = K (KWP protocol)
BDPECCCC.DZZ with E = ECU number (1 ... 9)

BDPECCCC.DzZz with D = J (Job or binary file), D = T (Trace file)
BDPECCCC.Dzz with ZZ = Job number (01 ... 99)

Beispiel non-recurring data (Acquisition no. 699 > BDPECCCC.DZZ)

Trace file BDU10699.T01 UDS protocol, ECU no. 1, Acquisition no. 699, Job no. 1
Binary file BDU10699.J01 UDS protocol, ECU no. 1, Acquisition no. 699, Job no. 1
CSV file BDJD0699.CSV Job overview of binary files

Measurement status file

Measurement status file in XML format offers information about the process of a completed acquisition. This
includes:

- Acquisition start and stop (... in standardized XML format “DataTime”)
- General system information (hardware, TESTdrive version,...)

- Storage group trigger

- Acquisition / Diagnosis information

- Limit violations

- Maneuver detection

Measurement status file is created after acquisition stop and is stored in the zip container of the acquisition
(MEA_xxxx.zip) or attached to the status e-mail if this file creation has previously been activated in
IPEmotion Options > Plugins > IPETRONIK LOG > Plugln specific settings > Options > General >
Create measurement status file.

Example Measurement status file (measurement number 699 > MSxxyyyy.xml)
xx = Append number, yyyy = Measurement number

Measurement status file 1 MS010699.xml
Messstatus status file 2 MS020699.xml

If an acquisition is later continued (Append mode), TESTdrive increases the append number in the file name.
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Min-Max list (STG file)

TESTdrive creates a separate file (STG file) to record minimum and maximum values of selected signals.

Example STG file (Acquisition no. 699 > STBBCCCC.STG)
STG file 1 ST010699.STG Min / Max data of storage / process group 1
STG file 2 ST020699.STG Min / Max data of storage / process group 2

Traffic recording (CAN, LIN)

TESTdrive saves traffic acquisitions in binary format. A traffic acquisition can include two binary files:
- Traffic data recorded by TESTdrive during boot time

- Traffic data recorded by TESTdrive during run time

Advice: Storage of CAN traffic data and LIN traffic data in the same file

The names of the single acquisition files are generated according to TBBBCCCC.BIN structure:

TBBBCCCC.BIN Traffic data recorded by TESTdrive
TBBBCCCC.BIN Consecutive number within an acquisition
TBQSCCCC.BIN Traffic data recorded by micro controller

Maneuver recording
TESTdrive creates a file in ASCII format for maneuver recordings.

The maneuver file functions like a storage group, i.e. the file receives a consecutive number within the
acquisition.

The names of the single acquisition files are generated according to MVBBCCCC.ASC structure:

MVBBCCCC.ASC Name of respective storage group

Example (Acquisition no. 699 > MVBBCCCC.ASC)

Storage group 1 DO010699.DAT Header
D0010699.116 16 Bit (Integer signed)
Storage group 2 DO020699.DAT Header
D0O020699.R32 32 Bit (Real)
Maneuver file MV030699.ASC
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